
New Features
in Final Cut Pro HD

HighNoonNFHome.qxp  3/4/04  3:44 PM  Page 1



 

 

 



 

 Apple Computer, Inc.
© 2004 Apple Computer, Inc. All rights reserved.

Under the copyright laws, this manual may not be 
copied, in whole or in part, without the written consent 
of Apple. Your rights to the software are governed by 
the accompanying software license agreement.

The Apple logo is a trademark of Apple Computer, Inc., 
registered in the U.S. and other countries. Use of the 
“keyboard” Apple logo (Option-Shift-K) for commercial 
purposes without the prior written consent of Apple 
may constitute trademark infringement and unfair 
competition in violation of federal and state laws.

Every effort has been made to ensure that the 
information in this manual is accurate. Apple Computer, 
Inc. is not responsible for printing or clerical errors.

Apple Computer, Inc.
1 Infinite Loop
Cupertino, CA 95014-2084
408-996-1010
www.apple.com

Apple, the Apple logo, DVD Studio Pro, Final Cut, 
Final Cut Pro, FireWire, Mac, Mac OS, Macintosh, 
PowerBook, Power Mac, and QuickTime are trademarks 
of Apple Computer, Inc., registered in the U.S. and other 
countries.

Cinema Tools, Finder, OfflineRT, LiveType, and Sound 
Manager are trademarks of Apple Computer, Inc.

Digital imagery

 

®

 

 copyright 2001 PhotoDisc, Inc.

AppleCare is a service mark of Apple Computer, Inc.

Other company and product names mentioned herein 
are trademarks of their respective companies. Mention 
of third-party products is for informational purposes 
only and constitutes neither an endorsement nor a 
recommendation. Apple assumes no responsibility with 
regard to the performance or use of these products.

 

UP01022.Book  Page 2  Tuesday, March 23, 2004  7:32 PM



 

    

 

 

 

3

 

3

 

Contents

 

Preface 7 New Features in Final Cut Pro
7

 

New Features in Final Cut Pro HD

 

7

 

High Definition Video

 

7

 

Editing

 

8

 

Film Editing

 

8

 

Timecode

 

9

 

Titles and Effects

 

10

 

Capture, Output, and, Media Management

 

11

 

External Monitoring

 

11

 

Preferences and Settings

 

12

 

New Features in Final Cut Pro 4.1

 

12

 

Editing

 

12

 

Audio

 

12

 

Media Management and File Interchange

 

13

 

External Monitoring

 

13

 

Support Features

 

14

 

New Features in Final Cut Pro 4.0

 

14

 

Improvements for Setup

 

15

 

Interface Enhancements

 

18

 

Preferences and Settings

 

20

 

Real-Time and Rendering

 

23

 

Capture and Output

 

27

 

Media and Clip Management

 

31

 

Editing

 

35

 

Audio

 

37

 

Effects

 

Chapter  1 41 Using DVCPRO HD
41

 

Getting Started With DVCPRO HD

 

41

 

DVCPRO HD Formats Supported in Final Cut Pro

 

43

 

Setting Up a DVCPRO HD Editing System

 

45

 

External Monitoring Setup

 

46

 

Capturing DVCPRO HD in Final Cut Pro

 

UP01022.Book  Page 3  Tuesday, March 23, 2004  7:32 PM



 

4

 

Contents

 

48

 

Editing DVCPRO HD in Final Cut Pro

 

48

 

Working With DVCPRO HD Timecode

 

50

 

Using Graphics and Effects With DVCPRO HD

 

50

 

Creating Graphics for HD Projects

 

51

 

Generating Color Bars and Tone for 1080i60 and 720p60 Video

 

51

 

Real Time and Rendering

 

51

 

Upconverting and Downconverting

 

51

 

Combining High Definition and Standard Definition Media in Sequences

 

55

 

DVCPRO HD Output in Final Cut Pro

 

55

 

720p Output and Playback

 

56

 

Offline and Online Editing Using DVCPRO HD

 

56

 

Capture and Media Management Workflows Using DVCPRO HD

 

60

 

Trading Project Files Using Email or the Internet

 

Chapter  2 63 Editing and Trimming
63

 

Copying and Pasting Clips in the Timeline

 

66

 

Filling a Timeline Gap With Slug

 

66

 

Adding Edits on Auto-Selected Tracks

 

66

 

Asymmetrical Trimming

 

68

 

Applying Filters to Multiple Tracks

 

68

 

Dynamic Trimming in the Trim Edit Window

 

68

 

Choosing Incoming and Outgoing Clips in the Trim Edit Window

 

69

 

Listening to Sequence Audio While Trimming

 

70

 

Changing View Options in the Timeline Track Layout Menu

 

70

 

Detecting Duplicate Frames Over Transitions

 

Chapter  3 71 Using LiveType Titles in Final Cut Pro

Chapter  4 73 Editing Film With Final Cut Pro in a PAL Environment
73

 

New Support for Conforming 25 fps to 24 fps and Exporting 25 fps EDLs

 

77

 

Exercises for Understanding 24 @ 25 fps Timecode

 

Chapter  5 83 Viewing and Modifying Timecode
83

 

Displaying Timecode in Final Cut Pro

 

88

 

Modifying Media File and Sequence Timecode

 

91

 

High Definition and Film Timecode Options

 

92

 

Generating Timecode Window Burns

 

Chapter  6 93 Media and Clip Management
93

 

Edit to Tape and Print to Video

 

93

 

Setting Minimum Allowable Space on Scratch Disks

 

94

 

Maximizing Media File Performance for Multiple Stream, Real-Time Playback

 

94

 

Determining the Application That Created a Clip

 

94

 

Creating Duplicate Master Clips in the Browser

 

UP01022.Book  Page 4  Tuesday, March 23, 2004  7:32 PM



 

Contents

 

5

 

95

 

Changing Affiliate Clips Into Independent Clips

 

95

 

Removing Subclip Limits

 

95

 

Automatic Naming of Captured Clips

 

96

 

Additional Settings in the Batch Capture Window

 

96

 

Display of Items in the Render Manager

 

96

 

Including Master Comment Information in EDLs

 

Chapter  7 97 External Audio and Video Monitoring
97

 

External Monitoring Setups

 

100

 

Challenges With External Monitoring

 

Appendix 103 High Definition Video Fundamentals
103

 

A Brief History of Film, Television, and Audio Formats

 

107

 

The Benefits of High Definition Video

 

108

 

High Definition Formats in Common Use

 

110

 

Discussing HD Formats in Conversation

 

111

 

Upconverting and Downconverting

 

112

 

Downconverting High Definition Video

 

115

 

Upconverting Standard Definition Video

 

116

 

DVCPRO HD Specifications

 

116

 

DVCPRO HD Tape Format

 

116

 

Aspect Ratio

 

117

 

Interlaced and Progressive Scanning Methods

 

117

 

Native Image Dimensions

 

118

 

Color Depth and Video Sampling Rate

 

118

 

Frame Rate

 

119

 

Versatile Formatting Choices With Digital Formats

 

120

 

DVCPRO HD Timecode

 

121

 

Brief Overview of DVCPRO HD Formats

 

121

 

1080i60

 

121

 

1080i50

 

122

 

720p60

 

122

 

720p30

 

123

 

720p24

 

124

 

Recording and Playing Back Variable Frame Rates With DVCPRO HD

 

UP01022.Book  Page 5  Tuesday, March 23, 2004  7:32 PM



 

UP01022.Book  Page 6  Tuesday, March 23, 2004  7:32 PM



 

    

 

 

 

7

 

Pr
ef

ac
e

 

New Features in Final Cut Pro HD

 

This is an overview of new features of Final Cut Pro, covering Final Cut Pro 4.0 through 
Final Cut Pro HD (version 4.5). New features not covered in the 

 

Final Cut Pro 4 
User’s Manual

 

 are described in depth in the following chapters.

 

New Features in Final Cut Pro HD

 

For more information on these features and their use, see the corresponding chapters 
in this document.

 

High Definition Video

 

Capturing, editing, and output of DVCPRO HD high definition video

 

Final Cut Pro HD natively supports DVCPRO HD media. You can capture, edit, and 
output DVCPRO HD video using the built-in FireWire port on a qualified Power Mac 
without any additional specialized equipment.

For details about working with DVCPRO HD in Final Cut Pro, see “Using DVCPRO HD” 
on page 41. For historical and background information about high definition video, see 
“High Definition Video Fundamentals” on page 103.

 

Editing

 

Copying and pasting clips follows track selection in the Timeline 

 

Final Cut Pro HD performs copying and pasting in the Timeline differently than 
Final Cut Pro 4.1 and earlier. When you copy clips from tracks in the Timeline, 
Final Cut Pro pastes those clips in the same tracks unless you specify different 
destination tracks by clicking their Auto Select controls.

For more information, see “Copying and Pasting Clips in the Timeline” on page 63.
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Listening to sequence audio while trimming

 

When trimming footage in the Trim Edit window, the following options are available in 
the Editing tab of the User Preferences window:

 

•

 

Trim with Sequence Audio: 

 

 Allows you listen to all sequence audio tracks while 
trimming in the Trim Edit window.

 

•

 

Trim with Edit Selection Audio (Mute Others):

 

  Mutes all audio tracks except the ones 
currently selected in the Timeline.

For more information, see “Listening to Sequence Audio While Trimming” on page 69.

 

Film Editing

 

New support for conforming 25 fps to 24 fps and exporting 25 fps EDLs

 

Final Cut Pro now provides features that let you conform 25 fps (PAL) media to 24 fps, 
edit at 24 fps, and export a 25 fps EDL. This is for situations in which your content 
originated on film and your negative cutter prefers to receive a 25 fps EDL from you 
instead of a film cut list. To allow you to edit at the same speed as the film and yet 
export an accurate 25 fps EDL for the negative cutter, the 25 fps timecode is 
maintained while the editing timebase of your sequence is 24 fps.

The new features that make this possible include:

 

•

 

A DV PAL 24 @ 25 Easy Setup and DV PAL 48 kHz - 24 @ 25 sequence preset
• A “Conform 25 to 24” command in the Tools menu
• The ability to export a 25 fps EDL from a 24 fps sequence
• A new source timecode rate called 24 @ 25

For more information about editing film using 24 @ 25 fps PAL video, see “Editing Film 
With Final Cut Pro in a PAL Environment” on page 73.

Timecode

New timecode display and modification options
Final Cut Pro HD displays timecode information differently than in earlier versions:
• Speed adjustments are no longer interpreted by the clip time display mode. Instead, 

a separate time mode called View Native Speed can be selected. The View Native 
Speed mode can be applied to source time or clip time modes.

• 60 @ 30 time display and 24 @ 25 frame rate are supported.
• New Project Properties allow you to set global timecode view settings per project.
• Sequence presets now have independent timecode rate and video frame rate 

(timebase) settings.

For more information, see “Viewing and Modifying Timecode” on page 83.
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New TC Rate Browser column and item property
The new TC Rate item property (visible in both the Browser columns and Item 
Properties) shows the source timecode rate of clips and sequences. Only the source 
timecode rate is displayed, not Aux 1 or Aux 2 timecode rates. Use the TC Rate Browser 
column to adjust the timecode rate for many clips at once. Some timecode rates are 
not allowed for some video frame rates.

Note:  TC Rate refers to the rate of a media file or sequence timecode track. Vid Rate 
refers to the frame rate of the video itself.

New timecode reader and generator filters
In Final Cut Pro HD, Timecode reading and generation are separated into two filters, 
replacing the Timecode Print filter. Both are located in the Video category of the Video 
Filters bin in the Effects tab.

For more information about the new timecode reader and generator filters, see 
“Generating Timecode Window Burns” on page 92.

Titles and Effects

Using LiveType with Final Cut Pro
You can directly import LiveType project files into Final Cut Pro. This eliminates the 
need to render a QuickTime movie of your LiveType title each time you want to use it in 
Final Cut Pro.

For details about working with LiveType projects directly in Final Cut Pro, see “Using 
LiveType Titles in Final Cut Pro” on page 71.

New Creator Browser column and item property
The Creator item property (visible in both the Browser columns and Item Properties) 
shows the name of the application that created the media file referenced by a clip.
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More real-time effects displayed in bold
In Final Cut Pro HD, the following filters and transitions are now capable of real-time 
playback when Unlimited RT is the selected real-time playback mode:

Filters
• Compound Arithmetic
• Bumpmap
• Displace
• Difference
• Image Mask
• Curl

Transitions
• Page Peel
• Gradient Wipe

Capture, Output, and, Media Management

Maximizing media file performance for multiple stream, real-time playback
Final Cut Pro automatically captures and writes media files to maximize the number of 
simultaneous streams and real-time effects during playback.

For more information about how Final Cut Pro optimizes media files, see “Maximizing 
Media File Performance for Multiple Stream, Real-Time Playback” on page 94.

Edit to Tape and Print to Video
In some instances, Edit to Tape and Print to Video used to require re-rendering of 
material in the Timeline prior to output. In Final Cut Pro HD, re-rendering is no longer 
necessary, significantly reducing rendering time before output.

Note:  Built-in countdowns, slates, color bars, and tone still require rendering before output.

Automatic recording with Print to Video
When printing to videotape, Final Cut Pro can automatically trigger recording on 
FireWire camcorders and decks.

For more information, see “Edit to Tape and Print to Video” on page 93.
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External Monitoring

Using a computer display for external video monitoring 
Final Cut Pro allows you to monitor Canvas or Viewer video using a computer display, 
simplifying your video editing system setup. If you have two computer displays, one 
can be used to view the Final Cut Pro interface and the Finder while the other can be 
used as a dedicated video monitor.

For more information, see “Using a Computer Display for External Video Monitoring” on 
page 99.

Preferences and Settings

New Editing tab in User Preferences
The User Preferences window contains a new tab for editing preferences. Many of the 
preferences in the new Editing preferences tab were formerly located in the General 
preferences tab.

Setting minimum allowable space on scratch disks 
Each time Final Cut Pro generates a new preference file, the Minimum Allowable Free 
Space On Scratch Disks number field is calculated based on a percentage of the first 
scratch disk selected in the Scratch Disks tab in the System Settings Preferences.

The minimum allowable disk space depends on whether the disk is currently a boot 
volume (the drive with the currently running operating system) or a non-boot volume:

• If the first scratch disk selected is a boot volume, 5% of the total drive capacity is 
automatically entered.

• If the first scratch disk selected is a non-boot volume, 1% of the total drive capacity is 
automatically entered.

You can adjust this value as needed.

Feedback command added to the Final Cut Pro menu
You can now launch the Apple Final Cut Pro feedback webpage directly from the 
application menu.
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New Features in Final Cut Pro 4.1
The following features were added in Final Cut Pro 4.1.

Editing

Choosing incoming and outgoing clips in the Trim Edit window
In the Trim Edit window, you can activate the outgoing or incoming clip by moving the 
pointer over it. The play button on the active Trim Edit viewer is highlighted. JKL keys 
only affect the currently active clip.

Filling a gap with slug now uses multiple edits
In Final Cut Pro 4.0 and earlier, filling a Timeline gap with slug performed a fit-to-fill 
operation, applying a constant speed change to the slug. In Final Cut Pro 4.1 and later, 
choosing the Fill with Slug shortcut command uses as many 2-minute slug generators 
as necessary to fill the gap.

Audio

Controlling audio levels in the Viewer
The new Source pop-up menu, located in the upper right of the Audio Mixer, selects 
whether Canvas or Viewer audio levels are controlled by the Audio Mixer. If you want 
the Audio Mixer to automatically switch between the Canvas and Viewer depending on 
which window you are using, choose Auto from the Source pop-up menu.

Media Management and File Interchange

XML interchange format support
Final Cut Pro project elements such as clips, bins, sequences, filters, keyframes, and 
markers can now be imported and exported using the new Final Cut Pro XML 
Interchange Format. Developers familiar with XML can now easily build tools for 
automatic sequence generation, clip management, and effects automation.
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Here are a few examples of how the new interchange format can benefit 
post-production workflows:

• Improve project compatibility between Final Cut Pro and other video editing systems
• Archive and manage databases of multiple Final Cut Pro projects
• Maintain multiple sequence versions in multisystem editing environments
• Enhance batch lists to include detailed log notes, comments, bins, subclips, merged 

clips, and master/affiliate clips
• Synchronize dual-system video and audio clips (typically used for film post-production)
• Automate effects and generator creation
• Automate text generator subtitle creation
• Complete access to motion, effects, and speed parameters within clips
• Change a sequence duration by batch processing parameters such as clip In points, 

durations, and locations within the sequence

For the latest technical specifications about the Apple XML Interchange Format, visit 
the Apple Applications page at the Apple Developer Connection website at
http://developer.apple.com/appleapplications.

External Monitoring

Frame offset for synchronizing an external monitor and the computer display
Final Cut Pro allows you to compensate for the delay between your computer display 
and external video and audio outputs. Frame offset is active only when your sequence 
real-time effects are handled by Final Cut Pro. For information about the settings in the 
Effects Handling tab of the Sequence Settings window, see Volume I, Chapter 6, 
“Viewing and Setting Preferences,” in the Final Cut Pro 4 User’s Manual. For more 
information about monitoring video externally, see “Compensating for Latency With 
Frame Offset” on page 101.

Support Features

Create support profile command has been added to the Help menu
There are certain support situations in which AppleCare may require information about 
both your computer and how this particular application is configured. Choosing 
Help > Create Support Profile creates a file that contains the necessary information and 
can be emailed to AppleCare. You would not normally use this feature unless directed 
to by an AppleCare representative.
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New Features in Final Cut Pro 4.0
This is an overview of the new features in Final Cut Pro 4.0. For more information on 
these features and their use, see the Final Cut Pro 4 User’s Manual or Final Cut Pro Help.

Improvements for Setup

Missing scratch disk warning
You are now warned when scratch disks become unavailable. This can happen for a 
number of reasons:  They might be turned off, disconnected, or temporarily 
unmounted. If the scratch disk folder you selected has been moved, deleted, or 
renamed, Final Cut Pro might not be able to find the scratch disk. The next time you 
open Final Cut Pro, if the scratch disk can’t be found, a dialog appears with three 
options: 
• Quit
• Set Scratch Disks to choose a new scratch disk
• Check Again, allowing you to reconnect or start up your scratch disk, wait for it to 

mount, and then proceed as usual

New screen layouts
There are several new screen layouts, including:
• Audio Mixing:  This places the Viewer, Canvas, and Tool Bench at the top of the screen. 

The Tool Bench window contains the Audio Mixer tab. The Browser and Timeline are 
on the bottom, with the Tool palette and audio meters to the right of the Timeline.

• Multiple Edits:  This layout only appears if your screen resolution is set to 1280 x 854 
or higher. This layout is useful for comparing three clips in a sequence in a row for 
color correction. At the top of the screen, from left to right, are the Viewer; a Tool 
Bench window with a Frame Viewer tab showing the previous edit point; the Canvas; 
and another Tool Bench window with a Frame Viewer tab showing the next edit 
point. The Browser and Timeline are on the bottom, with the Tool palette and audio 
meters to the right of the Timeline.

Other improvements to screen layouts include the following:

• You can now create and save multiple-monitor screen layouts.
• Screen layouts are now resolution specific; a new screen layout’s minimum required 

resolution is the resolution your monitor was set to when that layout was created.
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Interface Enhancements

Customizable keyboard shortcuts
All commands in Final Cut Pro can be assigned to customizable keyboard shortcuts 
using the Keyboard Layout window by choosing Tools > Keyboard Layout > Customize. 
The default keyboard shortcut layout can be changed at any time to better suit your 
needs. For example, if your style of editing requires a particular set of commands that 
isn’t readily available by default, you can modify the default keyboard layout with your 
own set of commands. 

You can also create different keyboard layouts for different tasks, switching between 
them at will. For example, you may find it useful to create different keyboard layouts for 
editing, color correction, and audio mixing.

Keyboard shortcut for Deselect All has changed
The default keyboard shortcut for Deselect All is now Shift-Command-A (not 
Command-D).

Keyboard shortcuts for Play Every Frame command
In the Viewer and Canvas, you can choose to play every frame of a clip. To do this using 
keyboard shortcuts, press Option-\ or Option-P.

Using keyboard shortcuts to zoom in and out of the Timeline
Pressing Option-+ (plus) or Option-– (minus) zooms in or out of the contents of the 
Timeline, as long as the Browser is not the active window. 

Customizable button bars in each window
Shortcut buttons can be created and placed along the top of the main windows in 
Final Cut Pro—the Browser, Viewer, Canvas, Timeline, and any Tool Bench windows. You 
can then click any of the shortcut buttons in this button bar to perform commands, 
instead of entering key combinations or using menus.

Resize multiple Final Cut Pro windows simultaneously
You can now place the pointer at the intersection of two or more windows in Final Cut Pro 
and resize all of them simultaneously when the Resize Window pointer appears. 

To resize multiple windows in Final Cut Pro, move the pointer over the border between 
the windows you want to resize. When the pointer changes to the Resize Window 
pointer, drag the border in the desired direction to resize the appropriate windows. The 
windows on either side of the border are resized accordingly.
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Resize individual tracks in the Timeline
You can change the size of individual tracks in the Timeline by dragging a track’s 
boundary in the Timeline patch panel: 
• If it’s a video track, drag the upper boundary of the track in the Timeline patch panel.
• If it’s an audio track, drag the lower boundary of the track in the Timeline patch panel.

New view options in the Timeline track layout menu
The Track Layout menu now includes five additional options. These options can also be 
set in the Timeline Options tab of the Sequence Settings window. 
• Show Video Filmstrips
• Show Audio Waveforms
• Show Through Edits
• Show Duplicate Frames
• Show Clip Labels (not available in the Timeline Options tab)

New default sequence settings
New sequences are now created by default with one video and four audio tracks. You 
can change this in the Timeline Options tab of the User Preferences window.

Save custom Timeline track layouts
Once you’ve created a custom track layout for your sequence, you can save it for future 
use. Saved custom track layouts appear in the Track Layout menu, and can be applied 
to any sequence that’s open in the Timeline. Up to 40 custom track layouts can appear 
in the menu at once.

New DV Sequences created with white setting
DV sequence presets in Final Cut Pro 4 use a default white point setting of White 
instead of Super-White. (There are several DV sequence presets that use Super-White; 
these are labeled as such.)

Assign destination tracks for editing using the new Timeline patch panel
Many editing operations in Final Cut Pro require you to use the Source controls in the 
Timeline to assign destination tracks to determine where edited, duplicated, or moved 
clips will appear. Source and Destination controls are located in the Timeline patch 
panel, at the left of the Timeline window.

When you open a clip or sequence into the Viewer, a number of Source controls appear 
in the Timeline patch panel and correspond to the number of video and audio items 
that make up that clip, or the number of tracks that appear in that sequence. For 
example, if you open a clip into the Viewer that contains one video and four audio 
items, one video and four audio Source controls appear in the Timeline patch panel.
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A merged clip may consist of 1 video and up to 24 audio items, so typically as many as 
25 Source controls will appear in the Timeline. You can also open a sequence into the 
Viewer, in which case as many as 99 video and 99 audio tracks can appear in the 
Timeline, depending on how many tracks there are in the sequence. Whenever you 
open a new clip or sequence into the Viewer, the number of Source controls in the 
Timeline patch panel updates to reflect the number of video and audio items in the 
new clip or sequence.

Auto Select controls in the Timeline
Enabling the Auto Select controls of specific tracks in the Timeline allows the contents 
of those tracks to be selected via In and Out points in the Timeline or Canvas, just as if 
you’d used the Range Selection tool. When In and Out points are defined in the 
Timeline, operations such as the Copy command and lift edits are limited to the 
selected regions of tracks that have Auto Select turned on.

When one or more Auto Select controls are enabled, regions of clips in the Timeline 
defined by In and Out points are highlighted, which indicates that these regions can be 
operated upon.

Mute and solo controls in the Timeline
Click a track’s mute button to turn off audio playback for that track. The mute button 
affects monitoring during playback only. When a track is muted, it isn’t audible during 
playback, but is still output during Print to Video and Edit to Tape operations, or when 
exported to an audio or movie file. The mute buttons for each channel in the Audio 
Mixer and the mute control in the Timeline editing controls are light amber when mute 
is enabled.

Click a track’s solo button to mute all tracks that don’t also have solo enabled. For 
example, if you click the solo button on track A1, and it’s the only track with solo 
selected, all other audio tracks are muted. If you enable the solo button on multiple 
tracks, all tracks with solo enabled play back, while all other tracks are muted. Like the 
mute button, the solo button affects monitoring during playback only. If solo is 
enabled on at least one track in a sequence, tracks that don’t have solo enabled are not 
audible during playback, but are still output during Print to Video and Edit to Tape 
operations, or when exported to an audio or movie file.

The solo button is dark red when turned on. When you solo a track, the mute controls 
of all non-soloed tracks are automatically turned light amber; this way, you can tell 
which tracks are soloed and which are muted, if other tracks are not displayed in the 
Timeline window.

UP01022.Book  Page 17  Tuesday, March 23, 2004  7:32 PM



18 Preface    New Features in Final Cut Pro HD

 

New Timeline zoom functionality
Timeline zoom functionality has been improved. You can zoom into the Timeline in any 
of the following ways:
• Drag the thumb tabs on either side of the Zoom slider to adjust both ends of your 

view at the same time. If the playhead is visible, it stays centered during the zoom. If 
the playhead is not visible, the visible area of the Timeline stays centered.

• Hold down the Shift key while you drag one of the thumb tabs to zoom in or out of 
your sequence from the selected end of the Zoom slider, while keeping the other 
thumb tab locked in place. This also moves the visible area of the Timeline in the 
direction you’re dragging as you zoom.

• Click or drag the Zoom control to view the Timeline at a different time scale while 
keeping either the playhead or the current area of the Timeline centered. Clicking to 
the right of the control zooms out to show more of your sequence; clicking to the 
left zooms in to show more detail.

Custom column layout menu in the Browser
You can create customized column layouts for your own specific uses, and save these 
arrangements as custom layouts for easy access at any time. The custom column 
layouts you save appear in the shortcut menu that appears when you Control-click any 
column heading in the Browser except the Name column.

Preferences and Settings

New organization of preferences
All preferences have been reorganized into two windows–User Preferences and System 
Settings.

Sync Adjust Movies Over preference has been removed
The Sync Adjust Movies Over preference available in earlier versions of Final Cut Pro has 
been removed from the General tab of the User Preferences window. The A/V sync of 
all captured clips in Final Cut Pro 4 is automatically maintained no matter which video 
device you capture from.

Memory usage settings
Two sliders in the Memory & Cache tab of the System Settings window allow you to 
decide how much of the RAM available in your computer to use when working in 
Final Cut Pro. Your computer’s available RAM is defined as the amount of RAM not used 
by Mac OS X and other currently open applications. By limiting the amount of RAM 
Final Cut Pro uses, you can maintain the performance of Final Cut Pro by preventing 
Mac OS X from using virtual memory unnecessarily. This is especially important when 
multiple applications are open at the same time.
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Additional Timeline display options
There are several new display options for the Timeline in the Timeline Options tab of 
the User Preferences window, including:
• Show Duplicate Frames:  Select this option to mark clips that are used more than once 

within a single edited sequence. Colored bars appear at the bottom of the clip’s 
video item in the Timeline if that clip has been used more than once. You can adjust 
the parameters that determine when duplicate frames indicators appear in the 
General Preferences tab.

• Show Audio Controls:  Select this option to display the mute and solo buttons to the 
left of each audio track in the Timeline. By default, these controls are hidden. Audio 
controls can also be displayed using the Audio Controls button in the Timeline.

• Video and audio keyframe editor:  The keyframe editor shows you keyframe graphs for 
motion effects or parameters of filters applied to clips in your sequence. These 
graphs are identical to those found in the keyframe graph area of the Motion and 
Filters tabs in the Viewer. You can edit keyframes in the keyframe editor using the 
Selection and Pen tools. The keyframe editor can only display the keyframe graph of 
one effect parameter at a time.

• Video and audio speed indicators:  Speed indicators show you the speed of clips in 
your sequence using tic marks. The spacing and color of these tic marks indicate the 
speed and playback direction of your clips. The speed indicators of clips in the 
Timeline update in real time as you make variable speed adjustments to clips in your 
sequence, showing you exactly how you’re altering a clip’s timing. There are no user-
adjustable controls in the speed indicator area.

Audio Outputs tab
The Audio Outputs tab contains a list of presets that allow you to define the number of 
audio output channels that are available to your sequence via external audio interfaces 
connected to your computer. The selected audio output preset is automatically 
assigned to all new sequences and projects you create. Each sequence in your project 
has its own individual audio output settings. After a sequence has been created, any 
future changes to its audio output settings must be made in the Audio Outputs tab of 
the Sequence Settings window.

Default location of Easy Setup files
By default, the files for Easy Setups you create are stored in the following location:   
/Library/Application Support/Final Cut Pro System Support/Custom Settings.

New location for third-party presets
To install third-party preset files or use preset files that you’ve moved, you must drag 
the desired preset files to the following folder:  
/Library/Application Support/Final Cut Pro System Support/Plugins.

The next time you open Final Cut Pro, the presets will be available in the Audio/Video 
Settings window.
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New location for locked presets
Presets are stored with the Easy Setup they are used with. If you want to lock a preset 
that you’ve created, you can make a custom Easy Setup and store it in the folder where 
locked Easy Setups are located. To lock a preset that you’ve created as part of a custom 
Easy Setup, drag your custom Easy Setup from 
/Library/Application Support/Final Cut Pro System Support/Custom Settings

to

/Library/Application Support/Final Cut Pro System Support/Plugins.

Note:  You must quit Final Cut Pro and reopen the application for the preset to appear 
locked in one of the preset tabs in the Audio/Video Settings window.

Real-Time and Rendering

Unlimited RT 
Selecting the Unlimited RT option in the RT pop-up menu of the Timeline allows 
Final Cut Pro to play additional real-time effects that exceed your computer’s real-time 
playback capabilities. Unrestricted real-time playback allows you play more effects, but 
increases the likelihood that your sequence will drop frames during playback. This 
mode is useful for getting a real-time preview of complex effects compositions.

RT pop-up menu in the Timeline
The Real-Time Effects (RT) pop-up menu allows you to adjust the playback quality of 
real-time effects in Final Cut Pro. Using the options in this menu, you can decide which 
is more important to you–visual playback quality or maximizing the available effects 
that can be played back in real time.

For example, if it’s more important to you to be able to view your program at the 
highest quality, you should deselect the Unlimited RT option and select the High 
playback option in this menu. This ensures that your program’s video quality is always 
as high as possible, and that no frames are dropped during playback. The tradeoff in 
this case is that the number of simultaneous real-time effects that can be played back 
is reduced.

If you’d rather lower the playback quality of your video in order to increase the number 
of real-time effects that can be played back, you can select the Unlimited RT and Low 
playback quality options to maximize your computer’s playback performance.

When you want to output your program to video, you can choose whether to render 
the effects that won’t output at full quality in real time, or output them at the reduced 
quality you’ve selected in order to avoid rendering.

Final Cut Pro always warns you before outputting video to tape at reduced quality 
when you use the Print to Video and Edit to Tape commands.
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Software-based real-time effects can be output using FireWire and other
built-in video interfaces
All real-time effects can be output to an external video monitor using FireWire or the 
built-in video output of a Macintosh PowerBook G4. This is true whether you’re using 
OfflineRT or DV source media in your projects. Outputting real-time effects to video 
using FireWire is a processor-intensive operation, requiring a very fast computer. 
Outputting this way will significantly reduce the maximum number of real-time effects 
that your computer can play in real time.

RT Scrubbing command removed from the sequence menu
The RT Scrubbing command available in the Sequence menu of earlier versions of 
Final Cut Pro has been removed. Improved performance makes it no longer necessary.

Real-time pull-down insertion for 24 fps sequences
If you’re editing 24 fps video, Final Cut Pro can play back and export your DV or 
OfflineRT sequence with 3:2 pull-down added. This lets you output 24 fps video to 
29.97 fps using FireWire or the built-in video output of a Macintosh PowerBook G4 for 
viewing or exporting to tape, all in real time.

Improved management of audio and video render cache files
Audio and video render cache files are handled differently, eliminating the need to 
rerender effects in many instances:
• Audio and video render cache files are now managed separately. Modifying video 

edits and making changes to video effects that overlap audio effects no longer 
affects rendered audio render cache files, and vice versa.

• Audio and video render cache files are preserved when clips are duplicated or copied 
and pasted.

• New item-level rendering of audio clips allows you to preserve audio cache files for 
audio effects and rendered resampling while making changes to volume and 
panning levels.
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Real-time effects playback and rendering options
Three new tabs allow you to control real-time effects playback and rendering in 
your projects:
• The Render Control tab in the User Preferences window allows you to enable and 

disable the most processor-intensive effects in Final Cut Pro. Changing the settings in 
the Render Control tab of the User Preferences window changes the default Render 
Control options that all new sequences are created with. To change the Render 
Control settings for existing sequences, alter these settings in your sequence’s 
Sequence Settings window.

• All settings in the Playback Control tab in the System Settings window remain the 
same for all sequences and projects opened on that computer. These settings also 
appear in the RT pop-up menu in the Timeline. Using these settings, you can decide 
which is more important to you–visual playback quality, or maximizing the available 
effects that can be played back in real time.

• The Effect Handling tab in the System Settings window allows you to set how real-
time effects are processed for clips compressed using a real-time-capable codec. This 
includes clips captured and compressed using the DV, DVCPRO50, and Photo JPEG 
codecs. Such clips, by default, can play back software-based real-time effects applied 
directly in Final Cut Pro. If a third-party capture card capable of real-time effects 
processing is installed that can process these codecs, you can reassign real-time 
effects handling to your hardware, instead.

Auto-rendering
The Auto Render preference allows you to take advantage of idle computer time when 
you’re not editing–such as during a coffee break or lunch–to render open sequences in 
the Timeline. Options in the General tab of the User Preferences window allow you to 
define how long to wait before rendering, which sequences to render, and whether or 
not to render real-time effects in the selected sequences.

Support for 10-bit video processing
Final Cut Pro now supports 10-bit video processing for selected filters and transitions.

UP01022.Book  Page 22  Tuesday, March 23, 2004  7:32 PM



Preface    New Features in Final Cut Pro HD 23

 

Capture and Output

Automatic timecode break handling during capture
New timecode break handling allows Final Cut Pro to automatically capture over 
timecode breaks without interruption. You can now capture the footage from an entire 
tape, skipping every timecode break on the tape. The “On timecode break” pop-up 
menu in the General tab of the User Preferences window gives you three ways to avoid 
capturing media with timecode breaks:
• Make New Clip:  This is the default option. Video that’s already been captured before 

the break in timecode is saved as a single clip, with its Out point set to the frame 
occurring immediately before the dropped timecode instance. Final Cut Pro then 
automatically continues capturing video after the dropped timecode frame as a 
second media file. When this option is selected, clips captured after timecode breaks 
are named with the original name plus a dash and the number of the clip. For 
example, if the first captured clip’s name is “Cats Playing,” then the second clip’s name 
is set to “Cats Playing-2.” This is a good setting if you are batch capturing an entire 
tape at once. For example, suppose you are capturing the entire contents of a 
60-minute tape that had four timecode breaks. Instead of making you restart capture 
every time a timecode break is detected, Final Cut Pro captures all media from the 
tape as five clips, skipping every timecode break and ensuring that the timecode of 
all captured media is frame-accurate and in sync.

• Abort Capture:  If this option is selected, capture is stopped whenever a timecode 
break is detected. All media captured before the timecode break has frame-accurate 
timecode and is preserved. The resulting open media clip is saved to the Browser.

• Warn After Capture:  If this option is selected, timecode breaks are reported after 
capture and the media file with the timecode break is preserved. It is unwise to use 
such a clip unless you have no choice, because timecode breaks result in incorrect 
timecode from the timecode break forward, and will impair your ability to accurately 
recapture your media.

Capturing audio and video to separate files now creates true merged clips
When you capture video and audio to separate files, two sets of media source files are 
saved on your hard disk, but the clips appear in your project as merged clips. Capturing 
your video and audio as separate files allows you to divide the workload between two 
scratch disks, maximizing the performance of each scratch disk you’re using so that you 
can capture your video at the highest possible data rate. Video and audio media files 
that have been captured separately are no longer dependent on one another.
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Automatic naming of captured clips
Automatic naming of captured clips in Final Cut Pro has been updated to remove extra 
zeroes from the beginning of a clip number. For example, in previous versions of 
Final Cut Pro, a series of clips would automatically be named and numbered as 
follows:  Untitled 0001, Untitled 0002, Untitled 0003. The extra zeroes in front of the 
number ensured that the clips would remain in sequential order once the clips reached 
0010 and 0100 respectively. Final Cut Pro no longer requires the extra zeroes in order to 
sort effectively. Now clips are automatically named and numbered as follows:  Untitled, 
Untitled 2, Untitled 3.

Additional settings in the Batch Capture window
In the Batch Capture window, when you select the Use Logged Clip Settings checkbox, 
additional settings are included for the captured clips:
• Image and Gain settings (for analog capture)
• Capture settings from the Capture pop-up menu
• Audio settings from the Audio Format pop-up menu

These settings are found in the Clip Settings tab of the Log and Capture window.

Field dominance of sequences with progressive scan clips must be set to None
Whenever you capture clips from progressive scan sources (such as cameras with a 
progressive scan mode), the field dominance of these clips should be set to None in 
the Format tab of the Item Properties window. You must also must make sure that all 
sequences you edit progressive scan clips into have their field dominance set to None. 
This prevents artifacts from occurring in motion effects that you apply to these clips.

Advanced pull-down removal
Select the “Remove Advanced Pulldown (2:3:3:2) From MiniDV Sources” setting of your 
capture preset if you’re capturing from a DV format source that used the 2:3:3:2 pull-
down method to capture 24P video. You want to remove the 2:3:3:2 pull-down to 
eliminate the redundant frame fields created by the pull-down so that you can edit 
true 24 (actually 23.98) fps progressive video.

Pull-down insertion
If you’re editing a sequence with a 23.98 fps timebase and you want to output to an 
NTSC device via FireWire, you can choose one of three pull-down insertion patterns 
from the RT pop-up menu in the Timeline. Pull-down insertion is a method of 
converting 23.98 fps video to the NTSC standard of 29.97 fps video. Depending on the 
speed of your computer, you can select from 2:3:2:3, 2:3:3:2, or 2:2:2:4 pull-down.

Control the quality of effects being output to video
When outputting a sequence with draft-quality proxy effects to video, you can choose 
whether to render the effects that won’t output at full quality in real time, or output 
them at the reduced quality you’ve selected in order to avoid rendering by choosing 
Use Playback Settings from the RT pop-up menu in the Timeline.
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Capturing audio using house sync
When capturing audio intended to be synchronized to video from a separate source, 
it’s important that your device-controllable audio deck be synchronized to your 
computer via a common video timing signal, such as a blackburst generator (also 
referred to as house sync). This is true even if you’re capturing your audio via a 
dedicated audio capture interface. This can be accomplished by connecting a 
blackburst generator to both the genlock connector (also called external sync) of your 
audio deck and to the genlock connector of an external video capture interface 
connected to your computer. When capturing audio from a genlocked audio deck, you 
need to select “Sync audio capture to video source if present” in the General tab of the 
User Preferences window.

Audio Sync tool for the Panasonic DVX-100
To address the way the Panasonic DVX-100 handles audio/video sync, the DVX-100 
Audio Sync Tool plug-in is available in the DV Camera Tuner Scripts folder on the 
Final Cut Pro 4 installation DVD. If you’re working with clips captured from the 
Panasonic DVX-100, you should move this plug-in to the following location:
/Library/Application Support/Final Cut Pro System Support/Plugins

When the DVX-100 Audio Sync Tool plug-in is installed, a new menu item appears in 
the Tools menu, Offset Audio Sync.

To use the Offset Audio Sync tool:
1 In the Browser, select any clips you captured that were recorded with the DVX-100.

2 Choose Tools > Offset Audio Sync.

The audio of all selected clips will be offset 2 frames later than the video to adjust 
their sync.

Note:  Adjustments made to clips using the Offset Audio Sync command are only saved 
in the Final Cut Pro project file where the adjustment was made. The corresponding 
source media on disk is unaffected.

Edit to Tape window has new icons
In the Video tab of the Edit to Tape window, two icons have changed. The Insert 
Timecode icon is now a yellow round clock icon, similar to the Timecode Duration and 
Current Timecode icons found in the Viewer and Canvas. The Insert Video icon is now a 
yellow frame of film with no letters.

Support for separate video and audio capture interfaces
You now have the ability to specify separate video and audio capture interfaces in the 
A/V Devices tab of the A/V Settings window.
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Support for multichannel audio output
Final Cut Pro supports audio output via up to 24 outputs using Mac OS X–compatible 
audio interfaces. The Audio Outputs tab of the Sequence Settings window allows you 
to define the number of audio output channels that are available to tracks in your 
sequence via the external audio interface connected to your computer. All audio tracks 
in a sequence can be assigned to specific pairs of audio outputs using the shortcut 
menu in each audio track header in the Timeline.

Support for multichannel audio during Edit to Tape operations
Using a Mac OS X–compatible audio interface, you can now output up to eight audio 
channels while using the Edit to Tape command. The number of audio tracks that can 
be recorded to when using the Edit to Tape command depends on the number of 
audio tracks your video or audio recording device supports.

When using a video or audio interface capable of outputting more than two channels 
of audio, you need to manually choose an appropriate audio track configuration based 
on the video or audio recording device you’re recording onto. You can specify this 
configuration by selecting or creating a device control preset, and setting the Audio 
Mapping pop-up menu in the Device Control Preset Editor to the appropriate 
configuration for your recording device. The Audio Mapping pop-up menu does not 
automatically detect the number of audio tracks your video or audio recording device 
is capable of recording to. You need to choose a configuration based on your recording 
device’s capabilities.

Edit to Tape audio insert pop-up menu has new states
Audio channels that are available to be recorded to can be enabled and disabled 
individually, or all at once. To record-enable an audio track, choose it from the Audio 
Insert pop-up menu and a checkmark appears next to it. Choose it a second time to 
remove the checkmark and disable the track.

Eight audio channel indicators in the Audio Insert pop-up menu indicate which audio 
tracks are being output. The color of an audio channel indicator indicates its state. The 
colors have changed. The following is an update replacing the audio channel indicators 
listed in the Final Cut Pro 4 User’s Manual.

• Yellow:  Indicates the audio track is available.
• Gray:  Indicates the audio track is unavailable.
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Support for audio interfaces with multiple input channels
During capture, Final Cut Pro only supports the first two channels of audio interfaces with 
multiple input channels. Any additional channels do not appear in the Audio/Video 
Settings window, and appear to have fewer output channels than they really support.

Despite this, the actual number of audio output channels supported by your audio 
interface is available for playback, Edit to Tape, and Print to Video operations. Audio 
outputs in sequences may be assigned to a maximum of 24 audio channels. In this 
situation, you may get a warning dialog improperly stating that the output map you’ve 
selected for this sequence contains more channels than the output device. If you know 
your audio interface supports the appropriate number of audio channels, you can 
ignore this alert.

Media and Clip Management

Viewing Item Properties for clips
The Item Properties window provides you with information for an individual clip. Three 
tabs in this window—Format, Timing, and Logging Information—allow you to view or 
change various properties of a clip. 

In the Browser, you can only view the Item Properties of one clip at a time. If you select 
more than one clip, you’ll only see information for the first clip. However, in the Timeline, 
you can select multiple clips and view all of their Item Properties in the same window.

To view Item Properties:
1 Do one of the following:

• Select a clip in the Browser.
• Select one or more clips in the Timeline.

2 Do one of the following:

• Choose Edit > Item Properties, then choose an option from the submenu.
• Control-click the clip, then choose Item Properties from the shortcut menu.

New master/affiliate clip relationships within a project
Final Cut Pro 4 introduces master/affiliate clip relationships for clips used in a project. 
The first instance of a clip that is captured or imported into a project is a master clip. 
Editing a master clip into a sequence or duplicating it in the Browser results in the 
creation of a sequence clip or duplicate clip that is an affiliate of the original master clip. 
A relationship exists between the original master clip in the Browser and all edited or 
duplicated affiliates of that clip that appear in every sequence and in every bin of that 
project. For any group of affiliated clips in a project, there is only one master clip.
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As a result of the relationship between master and affiliate clips, changes made to 
certain properties of a master clip, such as Clip Name, Reel Name, or Timecode, are 
automatically made to all affiliated clips within the current project. These same 
changes, if made to an affiliate clip, are also made to that clip’s master clip, as well as to 
all other affiliated clips in the current project.

The online or offline state of clips is also automatically updated among all affiliated 
clips in a project, all at once. Suppose you open a project in which all the clips are 
offline. Relinking that project’s master clips in the Browser automatically relinks all the 
affiliate clips that appear in each of that project’s sequences, as well.

New commands, including Reveal Master Clip, Duplicate as New Master Clip, and Make 
Independent Clip, allow you to manage these clip affiliations. The Match Frame 
command opens a clip’s affiliated master clip from the Browser.

Creating duplicate master clips in the Browser
To create a new master clip instance of a clip in the Browser, press Option while 
dragging a clip from the Timeline into the Browser, then press Command. When you 
see a pointer with M+ next to it, this indicates that a new master clip is being created; 
you can release the keys.

Changing affiliate clips into independent clips
As a result of the relationship between master and affiliate clips, changes made to 
certain properties of a master clip, such as Clip Name, Reel Name, or Timecode are 
automatically made to all affiliated clips within the current project. These same 
changes, if made to an affiliate clip, are also made to that clip’s master clip, as well as to 
all other affiliated clips in the current project.

The online or offline state of clips is also automatically updated among all affiliated 
clips in a project, all at once. Suppose you open a project in which all the clips are 
offline. Relinking that project’s master clips in the Browser automatically relinks all the 
affiliate clips that appear in each of that project’s sequences.

Depending on your project, you may choose to sever an affiliate clip from its master. This 
prevents the affiliate clip from updating with its master clip and other affiliate clips.

To make an affiliate clip in a sequence independent:
m Control-click the affiliate clip in the Timeline, then choose Make Independent Clip from 

the shortcut menu.

Your affiliate clip is now an independent clip. Any changes you make to this clip do not 
affect the master clip.
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Finding master clips
You may find it necessary to find the master clip in the Browser that is affiliated with a 
particular clip in the Timeline. You can do so using the Master Clip command.

To find an affiliate clip’s master clip:
1 Select a clip in the Timeline.

2 Choose View > Match Frame > Master Clip.

The master clip is automatically highlighted in the Browser.

Changing the label of a clip changes labels of all affiliated clips
If you use labels to identify and sort your clips in the Browser, the clips’ names are 
highlighted in the color that matches each label. Using keyboard shortcuts, you can 
change the labels of clips directly in the Timeline. Changes made to the label of any 
clip are also applied to all of that clip’s affiliated clips.

Support for merged clips using separate video and audio source media
A merged clip is one that links to more than one source media file on disk. For 
example, a merged clip might link to both a QuickTime video file and a separate audio 
file. Merged clips allow you to synchronize the audio and video items of footage shot 
via dual system recording. Instead of syncing your video and audio onto tape prior to 
capturing, you can capture your audio and video separately, and then merge them 
together in Final Cut Pro.

You can sync a video clip with up to 12 stereo or 24 mono audio clips (merged clips can 
contain a total of 1 video and 24 audio items) using their timecode, In points, or Out 
points. After a group of clips has been synchronized in preparation to create a merged 
clip, select them all and choose Modify > Merge Clips.

Linking clips in the Timeline prior to creating a merged clip
When creating a single merged clip by dragging multiple items from the Timeline into 
the Browser, all clips to be merged need to be selected and linked in the Timeline before 
they are dragged into the Browser. If you don’t link them in the Timeline first, each 
unlinked clip will appear as a separate item when the group is dragged into the Browser.

Note:  Only one video and up to 24 audio items can be linked together in the Timeline 
in preparation for making a merged clip.

Opening multichannel clips into the Viewer
If the In and Out points of a merged or linked clip’s audio don’t match, and you double-
click the clip in the Timeline, only the individual item you clicked opens into the Viewer. 
If you are in the Browser and open the same merged clip into the Viewer, all linked 
video and audio items open simultaneously in individual tabs in the Viewer.
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Removing subclip limits
As a result of the relationship between master and affiliate clips, changes made to 
certain properties of a master clip or subclip are automatically made to all affiliated 
clips within the current project. The same is true of subclips and any affiliates 
associated with them. 

In particular, if you extend the In and Out points on a subclip to those of the original 
master clip, your subclip now has all of the media in the original master clip. Therefore, 
if you remove the limits from one subclip, Final Cut Pro removes the limits from all 
other subclips associated with it.

Improvements to the Media Manager
Two new options give you more control over operations performed by the Media Manager.
• Include affiliate clips outside selection:  You can choose whether or not to include 

additional marked master clip media and other affiliated clips in the selected Media 
Manager operation. How much extra media will be included depends on whether or 
not the “Duplicate selected items and place into a new project” option is selected.

Including affiliate clips may dramatically increase the amount of media included by 
the Media Manager operation, but it will ensure that you include the maximum 
amount of useful footage by including master clip media that:

• Is marked by an In point, Out point, or both
• Falls between two unconnected clips derived from the same master clip
• Appears as an affiliate clip in another sequence

• Base media file names on:  This pop-up menu lets you determine how clips are named 
when they’re segmented as a result of the “Delete unused media” option. Since the 
clip names used in your project do not necessarily match the name of the source 
media files on disk (you may have renamed them manually, for example), you can 
specify which names to use. You have two options:
• Existing file names:  Filenames of clips created by the Media Manager are based on 

the source media files on disk.
• Clip names:  Filenames of clips created by the Media Manager are based on the 

names you’ve given the clips inside your project.

Improvements to the Item Properties window
The Item Properties window has been updated. Three tabs in this window—Format, 
Timing, and Logging Information—allow you to view or change various properties of 
a clip. The Item Properties window can now show information for a group of linked 
clips in a sequence, merged clips, and groups of sequence clips that have been 
opened simultaneously.
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Improved item linking in the Timeline
You can now link up to 1 video item and 24 audio items in the Timeline.

Additional support for modification of timecode in source media files
You can modify the Reel, Timecode, Aux 1, and Aux 2 timecode tracks directly in a clip’s 
source media file on disk.

Display of items in the Render Manager
Items in the Render Manager are now displayed in three groups:  audio, audio 
mixdown (sequence level audio render files), and video.

Including master comment information in EDLs
When you export an EDL, you can now choose to export Master Comments 1–4 or 
Comment A–B in the EDL Export dialog. These appear as notes in the EDL, letting 
offline editors give notes to the online editor about complicated entries on the list.

Editing

Dynamic trimming in the Trim Edit window
The Trim Edit window has a Dynamic checkbox that you can use to toggle dynamic 
trimming on and off, without having to go to the User Preferences window. This 
checkbox is located at the bottom of window, between the –1 and +1 Trim buttons.

Dupe detection
You can now turn on the Show Duplicate Frames option in the Timeline Options tab of 
the Sequence Settings window. This option marks clips that are used more than once 
within a single edited sequence with colored bars appearing at the bottom of the clip’s 
video item in the Timeline. Two options in the General tab of the Preferences window, 
Dupe Detection Handle Size and Dupe Detection Threshold, affect when and how 
duplicate frames indicators appear in the Timeline. 
• Dupe Detection Handle Size:  Adds frames to the beginning and end of the clip 

regions which are used for comparison, to determine whether or not to display 
duplicate frames indicators. This can be used to take into account the extra frames 
that must be used for physically cutting and cementing pieces of negative that are 
necessary for film matchback, to prevent you from accidentally including frames that 
can’t really be used. By default, this is set to 0.

• Dupe Detection Threshold:  Allows you to set a minimum number of frames that must 
be duplicated before a duplicate frame’s indicator will appear. By default, this is set to 
0 so that all instances of duplicated frames are indicated. You can set it as high as 99 
frames (3 to 4 seconds, depending on the frame rate), in which case there would 
have to be a minimum of 99 consecutive duplicated frames before a duplicate 
frames indicator would appear.
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Detecting duplicate frames over transitions
When Show Duplicate Frames is turned on in a sequence’s settings, duplicate frames 
that occur over the duration of a transition between two clips are indicated by white 
dots to the left and/or right of that transition. The side of the transition the dots appear 
on indicates the clip or clips that use duplicate frames.

Asymmetrical trimming in the Timeline
Asymmetrical trimming allows you to ripple edit opposite edit points of video and 
audio items in the Timeline separately. Using the Edit Selection tool, you can select an 
outgoing video edit point, and the opposite incoming audio edit points. When you use 
the ripple tool to trim these selected points, they move in opposite directions, allowing 
you to create a split edit.

Auto Select controls in the Timeline
Enabling the Auto Select controls of specific tracks in the Timeline allows the contents 
of those tracks to be selected via In and Out points in the Timeline or Canvas, just as if 
you’d used the Range Selection tool. When In and Out points are defined in the 
Timeline, operations such as the Copy command and lift edits are limited to the 
selected regions of tracks that have Auto Select turned on.

When one or more Auto Select controls are enabled, regions of clips in the Timeline 
defined by In and Out points are highlighted, which indicates that these regions can be 
operated upon.

Adding edits on auto-selected tracks
The Add Edit command (Control-V) in the Sequence menu works like the Razor Blade 
tool, adding an edit point to all clips in the Timeline at the current position of the 
playhead. This command works on all tracks with Auto Select turned on.

Locating a match frame
Finding a match frame can be useful if you want to quickly reedit a clip that’s already 
been edited into your sequence, or if you need to quickly access a sequence clip’s 
master clip to edit another part of it into your program.

To open a sequence clip’s master clip into the Viewer using the Match Frame option:
1 Position the playhead in the Canvas or Timeline on the clip you want to copy into the 

Viewer, at the specific frame that you want to locate.

2 Make sure the track that contains the clip you want to match is the destination track.

Editing clips from one sequence to another
Instead of nesting one sequence inside of another, you can edit the content of 
sequence A into sequence B–placing all of sequence A’s clips directly into the Timeline 
of sequence B exactly as they appear in sequence A–using the Command key. Hold 
down the Command key while dragging sequence A into the Canvas to edit the clips 
contained by sequence A into sequence B.
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Viewing clip time or source media time in the Viewer
You can view the timecode of a clip in the Viewer using either Clip Time or Source 
Time. Choosing Source Time guarantees that the current timecode displayed 
represents the timecode associated with that frame in your source media file. For 
example, if you change the speed of a clip to 50 percent, you effectively double the 
number of frames in that clip. With Source Time selected, each duplicated frame shows 
the correct timecode number of the frame in the media file it came from.

To choose either Clip Time or Source Time, Control-click in the current timecode 
window of the Viewer and choose a display method from the shortcut menu.

Ganging the Viewer and Canvas using the Playhead Sync pop-up menu
You can lock the playhead in the Viewer to the playhead in the Canvas so that they 
move together while scrubbing through clips. This is known as ganging. Ganging 
allows you to trim a clip in the Viewer by a duration specified by some event in the 
Timeline, such as the duration of an actor’s action, the length of a clip, or the distance 
between two markers. 

Ganging is especially useful when you’re modifying clips with color correction filters 
applied. When adjusting color correction filters, you want to see the Color Correction 
tab in the Viewer that corresponds to the clip in the Canvas so that you’re adjusting the 
right clip. Ganging lets you do this.

You use the Playhead Sync pop-up menu to choose from four different ganging options:

• Off:  Disables Viewer/Canvas ganging. The Viewer and Canvas playheads move 
independently of one another. This is the default behavior.

• Follow:  The playhead in the Viewer is locked to the playhead in the Canvas whenever 
a sequence clip is opened into the Viewer, so that both playheads scrub together, 
displaying the same frame. For example, moving the Timeline playhead to the 20th 
frame of a clip in your sequence also moves the Viewer playhead to the 20th frame 
of that sequence’s clip if it is also opened in the Viewer.

• Open:  This option is identical to Follow, except that as the playhead moves through 
your sequence, the clip that appears at the current position of the playhead is 
automatically opened into the Viewer. For example, moving the Timeline playhead 
from clip A in your sequence to clip B opens clip B into the Viewer, with the 
playheads in the Viewer and in the Canvas both ganged to the same frame.

The tab currently selected in the Viewer remains the selected tab, even though a 
new clip has been opened into it. The Open ganging option is useful when adjusting 
multiple clips that have color correction filters applied to them–as you move the 
playhead from clip to clip, the Color Correction tab updates to reflect the settings 
applied to whichever clip is at the current position of the playhead.
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• Gang:  When this option is selected, the offset between the current position of the 
playhead in the Canvas and the current position of the playhead in the Viewer is 
maintained as both playheads move together. This mode is useful for editing 
operations in which you want to mark In or Out points using durations defined by 
items or markers in the Timeline as your reference.

Opening items into the Viewer when the Playhead Sync Pop-Up menu is set to Open
When you choose the Open setting in the Playhead Sync pop-up menu in the Viewer, the 
playhead in the Viewer is locked to the playhead in the Canvas whenever a sequence clip 
is opened into the Viewer, so that both playheads scrub together, displaying the same 
frame. As the playhead moves through your sequence, the clip that appears at the 
current position of the playhead is automatically opened into the Viewer.

The order in which items open into the Viewer has changed. Final Cut Pro looks first for 
a video item on an Auto Select track, from top to bottom tracks, then for an audio item 
on an Auto Select track (bottom to top), then for a video item on any video track (top 
to bottom), then finally, an audio item on any track (bottom to top).

If you place the playhead over a gap, no new slug is opened into the Viewer. The 
Viewer displays the last clip opened.

Timecode navigation and shortcuts
There are several ways to enter and navigate using timecode. You can move the 
playhead to a specific frame by entering a complete timecode number in the Current 
Timecode field in the Canvas or Viewer, then press Return or Enter. You don’t need to 
click in the field to enter a new timecode; simply enter the timecode.

To avoid typing zeroes when moving by larger amounts, type a period instead. And 
instead of moving the playhead to an absolute timecode number, you can move it 
relative to its current position by pressing the + and – keys. For example, to move the 
playhead 1 minute and 20 frames back from the current position, type 

–01.20.

Note:  The period automatically adds 00 to the minutes and seconds field.
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Audio

Audio Mixer tab in the Tool Bench
A new Audio Mixer tab in the Tool Bench has controls comparable to those of an 
automated hardware mixing console. Each audio track in the currently selected 
sequence is represented by a track strip, complete with solo and mute buttons, a stereo 
panning slider, and a volume fader. You can make fine adjustments to the audio in your 
program by manipulating these graphical controls in real time while you listen to your 
program play back. Final Cut Pro records the gestures you make with the mixing 
controls, adjusting the levels of clips in your sequence accordingly. Adjusting the levels 
of your tracks this way as you listen to them play back allows you to create mixes more 
quickly than does directly manipulating a track’s volume overlays. The Audio Mixer tab 
has the following controls:
• Track strip controls allowing real-time mixing and automation recording for volume 

and panning levels
• Mute and solo monitoring controls
• Master level, master mute, and mixdown controls
• Individual track audio meters
• Master output meters showing mixed levels for each assigned audio output
• Controls to show and hide individual track strips
• Up to four different mixer views, each with a different set of visible track strips
• The ability to turn on and off keyframe recording

Real-time automation recording
When the Record Keyframes checkbox in the Audio Mixer tab or in the General tab of 
the User Preferences window is selected, Final Cut Pro records all changes you make to 
audio controls during playback as keyframes in the corresponding parameter overlay of 
the audio clip you are adjusting. This is referred to as recording mixer and effects 
automation. You can record automation in real time during playback for:
• Volume and panning levels using the fader and pan controls in the Audio Mixer tab
• Audio effects parameters using audio filter controls in the Filters tab of the Viewer

Slowing faders and panning sliders
Holding down the Command key while moving faders and panning sliders gears down 
their motion, allowing you to make more precise changes.

Mute overrides solo in the Timeline and Audio Mixer tab 
If a track’s solo control is already turned on, turning on mute overrides the solo status 
of that track and the track is silenced.
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Keyframe thinning
A new Audio Keyframe Thinning pop-up menu in the General tab of the User 
Preferences window allows you to control how detailed keyframe automation is when 
recorded using the Audio Mixer or audio filter controls. There are three choices.
• All:  Records the maximum number of keyframes possible while you move a track 

strip’s fader or panning slider. The end result is a precise re-creation of the levels you 
set using the Audio Mixer. The drawback to this option is that you might end up with 
an extremely dense cluster of keyframes in the audio level overlays of the affected 
clips that can be difficult to edit later.

• Reduced:  Reduces the number of recorded keyframes that are created when you 
move a track strip’s fader or panning slider. The resulting level or panning overlay in 
the Timeline or Viewer is an accurate reproduction of the levels you set, but is easier 
to edit using the Selection or Pen tool.

• Peaks Only:  Records only the minimum number of keyframes necessary to 
approximate the levels you recorded when moving a track strip’s fader or panning 
slider. Keyframes recorded using the Peaks Only option reflect only the highest and 
lowest levels that were recorded. This is primarily useful when you want to record a 
minimum number of keyframes to edit later in the Timeline or Viewer.

Support for multichannel output and Mac OS X–compatible audio interfaces
New support is available for specifying Mac OS X–compatible audio interfaces for 
capture and output in the Audio/Video Settings window. New settings in the Audio 
Outputs tab of the Sequence Settings window allow you to define the number of audio 
output channels that are available to assign to audio tracks from your sequence, using 
whichever external audio interface or third-party video capture card is connected to 
your computer. By default, a stereo preset is enabled, and will work with the audio 
output built in to your computer, as well as with most DV camcorders and third-party 
video capture interfaces. If you have a more sophisticated audio interface specified in 
the Audio/Video Settings window that supports more than two channels of audio 
output, you can create a new preset to define these additional audio output channels.

Export multiple audio outputs to AIFF files
The Export Audio to AIFF(s) command in the File > Export submenu gives you the 
opportunity to export every audio output channel that’s defined in the Audio Outputs 
tab of your sequence’s settings as a separate AIFF file. You also have the option of 
saving each exported AIFF file at 24-bit resolution, which is useful because Final Cut Pro 
mixes the audio in your program at 32-bit internal resolution, even if your source audio 
is 16 bit. Since all audio calculations are made with higher precision to maximize the 
quality of your program’s audio, using this command to export your audio preserves 
this quality.
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New support for Audio Units 
Final Cut Pro includes a set of Audio Units filters that you can use to adjust your 
audio clips. The Audio Units format is the standard Apple audio plug-in format for 
Mac OS X applications. 

Third-party Audio Units are also available; before purchasing third-party Audio Units 
filters for use with Final Cut Pro, check with the third-party manufacturer to make sure 
they’re compatible. Currently, Final Cut Pro only works with Audio Units filters that are 
capable of accepting mono audio as input, and can output a mono signal. Also, certain 
Audio Units filters that don’t support certain properties required by Final Cut Pro for 
real-time playback will require rendering before playback. For information on how to 
install third-party audio filters, see the information that accompanied them.

Rendering nested audio
When you add a nested audio sequence to a sequence in the Timeline and then render it, 
audio levels of individual channels are not reflected during playback in the Audio Mixer. A 
rendered nested audio sequence is mixed down to a stereo pair. Final Cut Pro 4 saves 
processing at the track level by reading the output only. This is also why you can’t 
perform mixer automation within a rendered nested audio sequence.

Effects

New real-time variable speed effects
You can now apply variable speed to a clip. Also referred to as time remapping, this 
allows you to dynamically alter the speed of a clip, alternating among a range of 
speeds, in forward or reverse motion, throughout any duration you specify. Variable 
speed allows you to create sophisticated motion effects in which subjects appear to 
smoothly shift across a variety of different speeds, with hard or gradual transitions 
between each change. Speed changes you apply to clips in your sequence play back in 
real time. There are two ways you can make variable speed adjustments.
• Timeline:  One of the simplest ways to make variable speed changes is to use the 

Time Remap tool in the Tool palette to make adjustments to clips directly in the 
Timeline. As you work with this tool, an outline of your clip appears that shows you 
which source frame in the clip is being remapped to what time. Optionally, you can 
choose to display speed indicators and a keyframe graph underneath that clip’s track 
in the Timeline, to help you see what you’re doing. 

• Time graph:  You can also add, subtract, smooth, and adjust time remap keyframes 
using the time graph of the keyframe editor in the Timeline or in the Effects tab of a 
clip in the Viewer.
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Speed indicators in the Timeline
Speed indicators underneath each track in the Timeline can be displayed, and show 
you the speed of clips in your sequence using tic marks. The spacing and color of these 
tic marks indicate the speed and playback direction of your clips. The speed indicators 
of clips in the Timeline update in real time as you make variable speed adjustments to 
clips in your sequence, showing you exactly how you’re altering a clip’s timing. There 
are no user-adjustable controls in the speed indicator area.

More real-time filters and motion effects
Many more of the Final Cut Pro video filters, audio filters, and transition effects have 
been optimized to work in real time.

New Timeline keyframe editor
Keyframe editor areas can be displayed underneath each track in the Timeline. The 
keyframe editor shows you keyframe graphs for motion effects or parameters of filters 
applied to clips in your sequence. These graphs are identical to those found in the 
keyframe graph area of the Motion and Filters tabs in the Viewer. You can edit 
keyframes in the keyframe editor using the Selection and Pen tools. The keyframe 
editor can only display the keyframe graph of one effect parameter at a time.

Keyframe graphs displayed in the keyframe editor are color-coded:  motion parameter 
graphs are blue (matching the color of the blue motion bar), filter parameter graphs 
are green (matching the color of the green filter bar), audio levels are pink, and 
panning levels are purple.

New Frame Viewer tabs
Frame Viewer tabs in Tool Bench windows can be used to visually compare multiple 
frames from the same sequence. This is particularly useful when performing a color 
comparison of multiple clips in the same setting where the lighting attributes may 
have changed. In Final Cut Pro, you can open as many Frame Viewer tabs in as many 
Tool Bench windows as necessary to compare as many frames as you need. If you’ve 
arranged multiple Frame Viewers to accomplish a specific task, you can save your 
custom configuration by choosing Window > Arrange > Save Window Layout. For more 
information about saving window layouts, see the Final Cut Pro 4 User’s Manual or 
Final Cut Pro Help, Volume I, Chapter 4, “The Final Cut Pro Interface.”

You can set a Frame Viewer tab to display the current frame, adjacent edit points, or the 
In and Out points in the Canvas and Timeline. You can also compare two frames within 
a single Frame Viewer tab using the split-screen buttons. You can split the screen either 
vertically or horizontally, or create a rectangular region showing the split as a picture-
in-picture. You can configure the Frame Viewer to display those individual frames that 
are most useful for making comparisons in your project.
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Improvements to the Color Corrector and Color Corrector 3-way filters
Additional features have been added to the Color Corrector and Color Corrector 
3-way filters.
• The Hue Matching controls provide a way to adjust the color balance of the current 

clip, based on a specific hue, to match a similar hue in another clip. A common 
example of when you might use the Hue Matching controls is to match the flesh 
tones of an actor in two different shots that have different lighting.

• New Edge Thin and Softening controls in the Limit Effect section of the Color 
Corrector and Color Corrector 3-way filters allow you to make fine adjustments.

New Color Smoothing filters 
Two new color filters (in the Key bin within the Video Filters bin) are available to aid in 
chroma keying video clips in Final Cut Pro. The Color Smoothing—4:1:1 filter improves 
the quality of chroma keys performed with DV-25 video clips. The Color Smoothing—
4:2:2 filter improves the quality of chroma keys performed with DVCPRO50 and 8- and 
10-bit uncompressed 4:2:2 video clips.

To improve the quality of your chroma key, apply the appropriate smoothing filter to 
the clip you want to chroma key first. As you add additional keying filters, make sure 
that the Color Smoothing filter you’ve used remains the first one in the video section of 
the Filters tab.

Note:  These filters may, in some instances, also be used to smooth out diagonal 
“stair-stepping” that can occur in video clips with areas of high-contrast color.

Applying filters to multiple tracks using Auto Select
When you apply a filter to a clip in a sequence, the filter is applied to all clips in tracks that 
have Auto Select turned on, just as if you’d used the Range Selection tool. However, filters 
are applied to the entire clip regardless of whether In and Out points are set.
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1 Using DVCPRO HD

Final Cut Pro combines the ease of DV and FireWire-based post production with the 
resolution of high definition video. Historically, editing high definition video has been 
prohibitively expensive for most film and video makers. Nonlinear high definition 
systems once required specialized video interfaces and costly high-speed disk arrays. In 
Final Cut Pro, you can capture, edit, and output DVCPRO HD video using the built-in 
FireWire port on a qualified Power Mac without any additional specialized equipment.

For additional background information about high definition video, see “High 
Definition Video Fundamentals” on page 103.

Getting Started With DVCPRO HD
DVCPRO HD is part of the DV/DVCPRO format family, making it simple to adapt your 
existing DV- and FireWire-based editing workflow to high definition video. For details 
about the DVCPRO HD format, see “DVCPRO HD Specifications” on page 116.

DVCPRO HD Formats Supported in Final Cut Pro
Final Cut Pro natively supports the following DVCPRO HD formats.

Format
Final Cut Pro
Easy Setup Dimensions Scanning method

1080i60 DVCPRO HD - 1080i60 1920 x 1080 Interlaced

720p60 DVCPRO HD - 720p60 1280 x 720 Progressive

720p30 DVCPRO HD - 720p30 1280 x 720 Progressive

720p24 DVCPRO HD - 720p24 1280 x 720 Progressive

UP01022.Book  Page 41  Tuesday, March 23, 2004  7:32 PM



42 Chapter 1    Using DVCPRO HD

 

Note:  Final Cut Pro also supports additional uncompressed high definition formats 
using third-party PCI cards. The table above shows only DVCPRO HD formats currently 
supported by Final Cut Pro.

Differences Between Standard and High Definition Video
High definition (HD) video has the following distinct advantages over standard 
definition (SD) video:
• Higher image quality because of significantly higher horizontal and vertical resolution
• Motion smoothness because of increased frame rates and progressive scanning method
• Widescreen, 16 x 9 aspect ratio versus standard definition with a 4 x 3 aspect ratio
• Eight or more audio channels available for a 5.1 (6-channel) surround sound mix and 

a stereo (2-channel) mix all on one tape
• Multiple frame rate and scanning (progressive or interlaced) choices for simple 

backward compatibility between HD and SD formats
• Advanced gamma correction circuitry for more film-like light response (not available 

in all HD cameras)

When Should I Use High Definition Video?
Choosing production and distribution formats for your project is a critical decision that 
will affect you from the first day of shooting to the very last screening. If you are trying 
to decide whether or not to use HD video on your next project, here are a few things to 
consider:
• High definition video is not a single format, but rather a family of formats that 

support a wide variety of frame rates, image sizes, and scanning methods.
• Unlike cameras for SD video formats, HD cameras and VTRs allow you to select image 

size and frame rate as necessary. For example, using an SD NTSC camera will restrict 
your video to an image size of 720 x 480 pixels and an interlaced frame rate of 
29.97 fps. Meanwhile, most HD cameras allow you to choose between several image 
sizes (1920 x 1080 or 1280 x 720), multiple frame rates (59.94, 29.97, or 23.98 fps) and 
progressive or interlaced scanning.

Format
Timebase
(on tape)

Timebase 
(in Final Cut Pro)

Source timecode
(in Final Cut Pro)

1080i60 29.97 frames per second
(59.94 fields per second)

29.97 fps 30 fps

720p60 59.94 fps 59.94 fps 30 fps

720p30 59.94 fps
(flagged as 29.97)

29.97 fps 30 fps

720p24 59.94 fps
(flagged as 23.976)

23.98 fps 30 fps
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To smooth the transition from standard definition to high definition video, most 
manufacturers have designed HD video devices to be cross-compatible with SD 
equipment by including built-in format converters. This flexibility has made high 
definition video a common production and post-production format even though it is a 
less common distribution format. Even if you are delivering your project on an SD 
format like DV or Digital Betacam, shooting and editing with an HD format will provide 
a future-proofed HD master and stunning image detail.

In some cases, your project’s distribution format makes HD the obvious choice for 
shooting and post production. If you plan to transfer and distribute your movie on film, 
HD is perfect because of its high resolution, aspect ratio, and 24 fps compatibility. HD is 
also useful in the following scenarios:

• As a practical substitute for broadcast television shows normally shot on film
• Trade show videos requiring widescreen, high-resolution formats
• Scientific and medical imaging that requires high-detail images
• Sports and other high motion applications
• International format distribution:  NTSC, PAL, and film all from a single HD master

Choosing a Frame Rate
Most DVCPRO HD cameras and decks allow two types of video frame rates:
• Integer frame rates such as 60, 30, and 24 fps
• NTSC-related frame rate variants such as 59.94, 29.97, and 23.98 fps

Currently, Final Cut Pro only supports NTSC-related timebases such as 59.94, 29.97, and 
23.98 fps when transferring video between a computer and a DVCPRO HD device via 
FireWire. Using tapes recorded with whole-number frame rates such as 60 fps or 30 fps 
is not supported in Final Cut Pro.

Setting Up a DVCPRO HD Editing System
Because DVCPRO HD is part of the DV/DVCPRO family of video formats, setting up 
Final Cut Pro to capture, edit, and output DVCPRO HD is essentially the same as setting 
up a system for any other kind of DV editing.

To set up your computer for DVCPRO HD input and output:

1 Connect your VTR to the computer via a 6-to-6 pin FireWire cable.

2 Choose an available scratch disk.

3 In Final Cut Pro, choose an Easy Setup that corresponds to your input and output format.

For additional instructions on connecting a DV deck or camcorder to your computer, 
see “Setting Up a DV System Using FireWire Device Control” in the Final Cut Pro 4 
User’s Manual.
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Determining Scratch Disk Requirements for DVCPRO HD
Before capturing video and audio, make sure your hard disks have sufficient capacity 
for your source footage plus some additional space for video and audio rendering. The 
table below compares the on-tape data rates for DVCPRO HD formats. The actual disk 
space used during capture will vary slightly depending on the number of audio 
channels captured.

Because DVCPRO HD is compressed, an internal 7200RPM ATA drive or serial ATA drive 
(used in computers with G5 processors) is sufficient for capturing DVCPRO HD.

In some cases FireWire drives can be effectively used to capture and edit DVCPRO HD 
video. However, some FireWire drives lack the performance of internal Ultra ATA drives, 
or of internal or external SCSI drives, and for this reason are not always recommended.

If you choose to use a FireWire drive, you should ensure that:

• The FireWire drive is the only FireWire device on the bus.
• The hard drive rotational speed is at least 7200 RPM.
• The hard drive can sustain minimum data rates appropriate for your video format.
• The hard drive uses a modern high-performance bridge chip such as the Oxford 911 

or 922.
• The hard drive uses its own power supply.

Choosing a DVCPRO HD Easy Setup
Final Cut Pro comes with several DVCPRO HD Easy Setups. Choose the Easy Setup that 
matches your source footage on tape and your output format (assuming they are the 
same). If your source footage and output format are different, it’s usually best to choose 
an Easy Setup that matches your source footage and convert your final movie to the 
output format when editing is complete.

If you need to create a custom Easy Setup, see “Working With Easy Setups, Presets, and 
the A/V Devices Tab” in the Final Cut Pro 4 User’s Manual.

Format Bits per second Bytes per second

1080i60, 720p60 100 Mbps 11.75 MB/sec.

720p30 50 Mbps 6.25 MB/sec.

720p24 40 Mbps 5 MB/sec.
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External Monitoring Setup
While editing, it’s best to watch your video and listen to your audio on external 
monitors. This is especially the case when using interlaced video because computer 
monitors can only show your video as progressive frames.

High definition video monitors have the ability to display 16 x 9 images and can accept 
a digital HD SDI signal (an extension of the SDI connection format used to transfer 
digital video information between professional equipment). However, HD monitors can 
be expensive and not always practical for offline editing purposes.

You can monitor DVCPRO HD footage in Final Cut Pro on an NTSC monitor by using a 
FireWire-capable DVCPRO HD deck with a built-in standards converter. In both cases, 
the VTR does the conversion from the FireWire DVCPRO HD signal to a video.

To monitor DVCPRO HD video on external video monitors:
1 Connect the computer to a DVCPRO HD VTR via a 6-to-6 pin FireWire cable.

2 Connect the standards converter output of the VTR to an NTSC monitor or PAL monitor 
(depending on the HD format you are using) via composite or component connections.

3 Optionally, connect the HD SDI output of the VTR to the HD SDI input of the external 
monitor (if available).

4 Connect the left and right audio channels to two self-powered speakers, or to a mixer, 
amplifier, and passive speaker system.

Audio

FireWire Composite

Computer

DVCPRO HD
VTR

NTSC/PAL
monitor

Amplified speakers

Audio

FireWire HD SDI

Computer

Amplified speakers

DVCPRO HD
VTR

HD SDI
monitor
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Note:  Not all DVCPRO HD VTRs convert between all HD and SD standards. Check with 
the VTR manual or manufacturer to make sure the type of external monitor (NTSC or 
PAL, composite, component, or HD SDI) you are using is compatible with the 
DVCPRO HD formats supported by the VTR.

Capturing DVCPRO HD in Final Cut Pro
Capturing DVCPRO HD video in Final Cut Pro works just like capturing from any other 
DV device.

About DVCPRO HD Device Control 
Although 720p HD formats can record 59.94 and 60 fps, remote VTR control is 
communicated via SMPTE 30 fps timecode positional information. This means that 
during capture and output, you can only mark In and Out points with 30 fps timecode 
accuracy. However, you can edit with 59.94 and 60 fps frame accuracy within 
Final Cut Pro. For more information about 60 fps timecode, see “720p60 and 
60 @ 30 fps Timecode” on page 49 and “60 @ 30 Timecode” on page 91.

Choosing a Capture Preset
Final Cut Pro HD includes new DVCPRO HD capture presets. Before capturing, do the 
following:
• Choose a capture preset that matches your DVCPRO HD footage on tape.
• Choose whether to capture your audio as a pair of discrete mono channels or as a 

stereo pair, or as a single audio channel.

Setting Audio Capture Settings
Some DVCPRO HD VTRs provide up to eight audio channels for recording and playback. 
Currently, Final Cut Pro can capture audio channels 1 and 2 in the following 
combinations:
• Channels 1 and 2 (stereo pair)
• Channels 1 and 2 (discrete mono)
• Channel 1 (mono)
• Channel 2 (mono)

Warning:  Make sure you choose a capture preset that matches the tape from which 
you are capturing.
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Capturing 720p30 and 720p24 DVCPRO HD Video
DVCPRO HD always records and plays back 720p video at 59.94 fps or 60 fps, but 
alternate frame rates can be simulated by flagging certain frames for removal during 
capture or playback. For example, if you choose to record 720p with a frame rate of 
29.97 fps, the camera is actually recording at 59.94 fps, but every other frame is a 
duplicate frame that Final Cut Pro will ignore during capture.

Captured in Final Cut Pro (59.94 fps)

242322212019181716151413121110987654321

Captured in Final Cut Pro (23.98 fps)

Used frames Deleted frames

DVCPRO HD tape (59.94 fps)

Capturing DVCPRO HD:  720p60, 30, and 24

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 601

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 601

Captured in Final Cut Pro (29.97 fps)

302928272625242322212019181716151413121110987654321

DVCPRO HD tape (59.94 fps)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60

DVCPRO HD tape (59.94 fps)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60
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The 720p30 and 720p24 capture presets enable the checkbox that tells Final Cut Pro 
whether or not to remove camera-tagged duplicate frames when shooting at frame 
rates other than 59.94 fps.

Editing DVCPRO HD in Final Cut Pro
Once you have your DVCPRO HD media captured to the hard disk, you can edit it just 
as you would any other DV media. Final Cut Pro features that are unique to DVCPRO HD 
formats are discussed below.

Working With DVCPRO HD Timecode
There are several timecode formats available depending on the high definition format 
you are editing:
• 60 fps timecode
• 60 @ 30 fps timecode
• 30 fps timecode
• 24 fps timecode

Select to remove
duplicate video frames

during capture.
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720p60 and 60 @ 30 fps Timecode
When editing 59.94 fps video, Final Cut Pro supports two time display options.
• 60 fps timecode:  The timecode counts 60 frames per second, from :00 to :59.
• 60 @ 30 timecode:  Displays 30 fps timecode with the addition of an asterisk on every 

other frame. This time display matches the display on DVCPRO HD decks, and is 
useful when you are referring to log notes or EDLs generated with 30 fps timecode. 
The 60 @ 30 timecode format maintains compatibility when you are cross-converting 
between HD and NTSC SD video.

To toggle the time display between 60 fps and 60 @ 30 fps:

1 Open a 720p60 clip or sequence in the Viewer or Canvas.

2 Control-click a timecode field, then choose Non-Drop Frame (this will display 60 fps 
timecode) or 60 @ 30 from the shortcut menu.

Note:  The 60 @ 30 time display is only available when you are working with 59.94 fps 
or 60 fps media files and sequences. 720p formats do not support drop frame 
timecode modes.

01:50:20:29

01:50:20:29*

01:50:21:00

01:50:21:00*

01:50:20:28

01:50:20:28*

01:50:20:58

01:50:20:59

01:50:21:00

01:50:21:01

01:50:20:56

01:50:20:57

60 fps60 @ 30 fpsFrames
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Using 30 fps Timecode With 720p30 and 1080i60
1080i60 and 720p30 formats both use 30 fps timecode. 720p30 has one timecode 
number per progressive frame, while 1080i60 has one timecode number per two 
interlaced fields.

Note:  The option to show drop frame timecode is only available if your media file has 
a frame rate of 29.97 fps. 30 fps media files can only have a time display of 30 fps, 
non-drop frame timecode.

Using 24 fps Timecode With 720p24
On tape, 720p24 records 30 fps timecode. Even though the frame rate of 720p24 media 
files is 24 fps (or 23.98 fps), the timecode track is captured at 30 fps. In Final Cut Pro, 
you may choose to view this timecode in two ways:
• Source time:  30 fps timecode from the source media file, which corresponds to the 

original source tapes
• Clip time:  24 fps timecode displayed based on the 24 fps (or 23.98 fps) frame rate of 

the media file

Important:  The frame rate (or timebase) of a media file is independent of its timecode 
track rate, although they are usually related. 720p24 is an example of a media file that 
has a frame rate and a timecode rate that differ.

Using Graphics and Effects With DVCPRO HD

Creating Graphics for HD Projects
Creating graphics and still images for high definition video projects is the same process 
as for standard definition video. To determine the image dimensions for your sequence, 
follow the guidelines below.

Note:  Unlike standard definition video formats, which use rectangular pixels, high 
definition video formats use square pixels. You don’t have to worry about adjusting 
high definition image dimensions before importing your graphics into Final Cut Pro.

Sequence preset Still image dimensions

1080i 1920 horizontal x 1080 vertical

720p 1280 horizontal x 720 vertical
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Generating Color Bars and Tone for 1080i60 and 720p60 Video
Bars and tone generators are available for use with1080i60 and 720p60 sequences. 
720p30 and 720p24 sequences can also use 720p60 Bars and Tone.

Real Time and Rendering
High definition video requires more disk space, processing power, and rendering time 
than standard definition video. Despite the increased demands of high definition video, 
Final Cut Pro supports real-time effects whenever possible.

Media with a lower frame rate and smaller image dimensions, such as 720p24, are able 
to achieve more real-time playback than formats like 1080i60.

Upconverting and Downconverting

Combining High Definition and Standard Definition 
Media in Sequences
During the transition from SD to HD video, many editors encounter situations where 
they must mix HD and SD video on the same Timeline, or different HD frame sizes in 
the same sequence. For an introduction to converting between high definition and 
standard definition formats, see “Downconverting High Definition Video” on page 112 
and “Upconverting Standard Definition Video” on page 115.

Because Final Cut Pro is resolution independent, you are free to add any clips in the 
Browser to a sequence, but clips that do not match the current sequence preset almost 
always need to be rendered during playback (indicated by a red bar above the clip in 
the Timeline). 

If you are mixing a lot of standard and high definition video footage in a single 
sequence, it’s often more efficient to convert all your footage to a common format so 
that all your clips have the same dimensions, frame rate, and codec before continuing 
to edit your project. You can convert many clips at once using the Batch Export 
function or the Media Manager.

For details about using the Batch Export command, see Volume I, Chapter 16, 
“QuickTime Export of Video, Images, and Sound,” in the Final Cut Pro 4 User’s Manual. 
For more information about the Media Manager, see Volume II, Chapter 16, “Using the 
Media Manager” in the Final Cut Pro 4 User’s Manual.

Tip:  Whenever possible, combine SD and HD media that have matching frame rates.

UP01022.Book  Page 51  Tuesday, March 23, 2004  7:32 PM



52 Chapter 1    Using DVCPRO HD

 

Upconverting Standard Definition Media for Use 
in High Definition Sequences
Converting a video format to a higher resolution format is called upconverting. 
Upconverting standard definition media to high definition can be done by scaling the 
SD clip placed in the HD sequence.

To scale and pillarbox a 720 x 480 standard definition clip into a 1280 x 720 
high definition sequence:

1 Open the standard definition sequence clip in the Viewer by double-clicking it in 
the Timeline.

2 In the Viewer, click the Motion tab.

3 Open the Basic Motion parameters by clicking the disclosure triangle.

4 Type 150 in the Scale number field.

5 Open the Distort parameters by clicking the disclosure triangle.

6 Type 12.5 in the Aspect Ratio number field.

Note:  The aspect ratio value may already be set if you have edited this clip into a high 
definition sequence.

Side panel Side panel
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Similar upconverting can be done by following the steps above and replacing the 
appropriate numbers with the numbers shown in the table below.

To clear the scale and aspect ratio settings of a clip in the Timeline:
1 Open the standard definition sequence clip in the Viewer by double-clicking it in 

the Timeline.

2 In the Viewer, click the Motion tab.

3 Next to the Basic Motion settings, click the red x to reset the scale settings, or type 100 
in the number field labeled Scale.

4 Next to the Distort settings, click the red x to reset the aspect ratio settings in the 
number field labeled Aspect Ratio.

Downconverting High Definition to Standard Definition Video
High definition video frames are larger than standard definition frames, and they have 
a wider aspect ratio. Any method of converting HD media to SD is known as 
downconverting.

It is more common to downconvert an entire HD sequence to SD as opposed to using 
individual HD clips in an SD sequence, but in both cases you need to choose how the 
higher resolution 16 x 9 HD frame is placed in the lower resolution 4 x 3 frame.

You can also downconvert your high definition video within Final Cut Pro by nesting 
your HD sequence within an SD sequence that matches your output format. For 
example, if your output format is DV NTSC, nest your DVCPRO HD sequence in a DV 
NTSC sequence.

Some particular techniques for downconverting HD video to SD are listed below.

Original 
clip size

Destination 
sequence size

Scale 
(Motion tab)

Aspect ratio
(Motion tab)

720 x 480 1280 x 720 150 50

720 x 480
anamorphic

1280 x 720 150 50

720 x 480 1920 x 1080 225 68.75

720 x 480
anamorphic

1920 x 1080 150 12.5

1280 x 720 1920 x 1080 150 12.5
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Pan and Scan
You can crop and even perform simple pans by animating the origin parameters in the 
Motion tab. For more information on using the Motion tab and animating parameters, 
see Volume III, Chapter 2, “Creating Motion Effects and Using Keyframes,” in the 
Final Cut Pro 4 User’s Manual.

Letterboxing
You can scale the entire HD movie by nesting and scaling it into an SD sequence. You 
will have to render the whole sequence before you output.

Warning:  It is difficult to add a convincing pan into a scene that did not originally 
have one. Use this technique sparingly.
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DVCPRO HD Output in Final Cut Pro
DVCPRO HD clips and sequences are recorded to tape via FireWire, just like any other 
DV media. For more information about editing to tape, see Volume I, Chapter 15, 
“Editing to Tape,” in the Final Cut Pro 4 User’s Manual.

720p Output and Playback
720p DVCPRO HD provides several frame rate options during recording and playback 
(60, 30, 24), but the actual frame rate used is always 59.94 fps (over FireWire) or 60 fps.

720p30 and 720p24 Output
When recording 720p30 or 24 to tape, Final Cut Pro automatically outputs 59.94 fps 
video, creating and tagging duplicate frames.

For more information about how DVCPRO HD flags 59.94 fps frames with alternate 
frame rate information, see “Recording and Playing Back Variable Frame Rates 
With DVCPRO HD” on page 124.

For information about editing your clips or sequences to a particular timecode position 
on tape using the Edit to Tape window, see Volume I, Chapter 15, “Editing to Tape,” in 
the Final Cut Pro 4 User’s Manual.

For information about manually recording clips or sequences from Final Cut Pro to your 
video deck, see Volume I, Chapter 14, “Recording to Videotape,“ in the Final Cut Pro 4 
User’s Manual.

Warning:  Don’t record DVCPRO HD video to a tape that already has DVCPPO (25) or 
DVCPRO 50 footage on it. Even though these formats can use the same tape stock, 
the recording speeds are different.
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Offline and Online Editing Using DVCPRO HD
Because formats like DV and DVCPRO HD are already compressed (yet still acceptable 
quality), many people choose to do their rough logging, assembly, and editing at full 
native resolution. When you plan your post-production workflow, it’s critical to 
understand whether you plan to do rough cutting at native resolution (full-quality, 
offline editing) or rough cutting at lower resolution (offline editing that will require 
high-quality recapture of select clips later).

Capture and Media Management Workflows 
Using DVCPRO HD
Final Cut Pro allows you to design any post-production workflow that suits your 
project. Some of the more commonly used workflows are described below.

Rough Editing With Native Resolution DVCPRO HD
This is the simplest post-production workflow for a DVCPRO HD project. For cuts-only 
editing, there will be no generational quality loss from tape to Final Cut Pro and back. 
Titles, effects, and dissolves will require some processing of the video signal that is 
acceptable for most distribution formats, but may not be acceptable for high-end 
formats such as major network television broadcast or film output.

VTRHard disk

Sequence

Offline
Capture low resolution

Edit

Online
Capture full resolution

VTR

VTR

Hard disk

Hard disk

Sequence

Output
Full resolution

Hard disk

Sequence
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To capture, edit, and output a project using native resolution DVCPRO HD video:
1 Choose an Easy Setup or capture preset that matches your DVCPRO HD source footage.

2 Log footage before capture, deciding which clips to capture.

3 Capture selected DVCPRO HD footage via FireWire.

4 Create a sequence using an Easy Setup or sequence preset that matches your source 
footage.

5 Edit as necessary.

6 Output back to DVCPRO HD tape using Edit to Tape or Print to Video.

Rough Editing With Low-Resolution, Offline-Quality DVCPRO HD
This workflow uses the Media Manager to create low-resolution, offline-quality versions 
of your media files. Ultimately, this process requires less disk space than editing at full 
resolution, but each tape captured will initially require enough disk capacity for both 
full-resolution and low-resolution versions of your media.

This process makes two projects, two sets of clips, and two sets of media files. One 
project contains all of the full-resolution DVCPRO HD clips that reference the full-
resolution DVCPRO HD media files on your scratch disk. The second project, which you 
will create using the Media Manager, will look identical to the first except that the clips 
will reference offline-quality clips on your scratch disk. This second project, along with 
its associated media files, will require significantly less disk space and processing power. 
You can copy these files to an external FireWire drive or an internal PowerBook drive 
and edit the project remotely. If disk space is a concern on the original scratch disk, you 
can throw away the full-resolution DVCPRO HD media files, keeping only the offline-
quality media files.

If any new DVCPRO HD footage is shot and captured, it must go through the same 
Media Manager process and then be added to the offline-quality project.

Recompress

Tape
(capture full resolution)

Scratch disk
(enough disk space for both 
full and low resolution files)

D Duplicate items

Project
(full resolution)

Project
(low resolution)

Clip

Clip

B

A

C

A

B

C

D
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When your rough editing is complete, you can return to your original source tapes and 
recapture only the media necessary to create the final edited sequence. The result will 
be a full-resolution DVCPRO HD sequence ready for full-resolution output.

Although you may choose any offline-quality format that suits your project, the 
following table shows corresponding DVCPRO HD and OfflineRT HD presets that ship 
with Final Cut Pro.

To capture media at full resolution and recompress at OfflineRT HD resolution:
1 Choose an Easy Setup or capture preset that matches your DVCPRO HD source footage.

2 Log footage before capture, deciding which clips to capture.

3 Capture selected DVCPRO HD footage via FireWire.

4 Once you have captured all the clips you need for your project, select all the clips in the 
project, then choose File > Media Manager.

Note:  Placing all the clips in a single bin and then selecting the bin also works.

5 In the Media Manager, choose the following options, then click OK.

6 Once the Media Manager has finished creating OfflineRT media files and a project that 
references them, copy this project and its associated media files to an external hard 
drive or PowerBook for remote editing.

Online, full-resolution preset Offline, low-resolution preset

DVCPRO HD 1080i60 OfflineRT HD 29.97

DVCPRO HD 720p30 OfflineRT HD 29.97

DVCPRO HD 720p24 OfflineRT HD 23.98

Choose Recompress from
this pop-up menu.

Make sure these options
are selected.

Choose the codec you want to use for 
recompressing.

Click here to choose a location 
for the recompressed media files.
If your PowerBook is connected,
you can copy files directly to it.
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To edit your OfflineRT project:
1 In the OfflineRT project, create a sequence using a sequence preset that matches your 

OfflineRT source footage.

2 Edit the sequence just as you would with full-resolution clips.

When you finish editing, you can capture the full-resolution media necessary to create 
the final sequence. You need to create a duplicate sequence that has full-resolution 
settings (for both the sequence and the clips within). This sequence can be created 
with the Media Manager.

Note:  The sequence is called an offline sequence, but in this case the term offline refers 
to the fact that all of the media will be considered offline (in other words, disconnected 
from the clips). It does not mean that the sequence or clips will be offline-quality.

To recapture the media in your sequence at full resolution:
1 In the OfflineRT project, select your sequence in the Browser and choose 

File > Media Manager.

2 In the Media Manager, choose the following options, then click OK.

Note:  If you anticipate additional fine-tuning of your edits, or if you plan to change the 
length of transitions such as dissolves and fades, you can select the Use Handles 
checkbox and enter a handle length (in seconds and frames) to provide extra media at 
the head and tail of each sequence clip. Don’t set this value too high or it will 
significantly increase the amount of media you need to recapture. 2–5 second handles 
are usually adequate for sequences near completion.

Choose Create Offline
from this pop-up menu.

Select this option.
Choose the preset that matches 
your original source tapes.

Deselect this option
to avoid creating

extraneous clips in
your new project.
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3 In the Save dialog, choose a name and destination for the new project file.

4 Once saved, open the new project in Final Cut Pro.

Note:  To avoid confusion, close the original low-resolution project if it is still open.

5 In the Browser, select your edited sequence and choose File > Batch Capture.

For more information about batch capturing, see Volume I, Chapter 10, “Logging and 
Capturing Media” in the Final Cut Pro 4 User’s Manual.

When you have finished capturing all of your clips at full resolution, you can output 
back to DVCPRO HD tape using Edit to Tape or Print to Video.

Trading Project Files Using Email or the Internet
To send a project via the Internet or email, you can use the Media Manager to create a 
copy of your project without media, reducing transfer time significantly. Keep in mind 
that recipients of your project need the same media files on their systems; otherwise, 
they will only see offline media indicators when they open the project. Use the copy or 
recompress option in the Media Manager to create copies of your media files for 
remote collaborators.

The example below shows how to make a copy of your sequence(s) with different 
sequence settings (image dimensions, codec, and so on) to send to a remote 
collaborator. You do not actually create any new media.

To use the Media Manager to create an offline sequence within a new project file:
1 Select a sequence in the Browser.

2 Choose Make Offline in the Media Manager.

3 Select the sequence preset that matches the media on the editing system you are 
sending to.

4 In the Media Manager, click OK.

5 Choose a destination and name for the new project file, then click OK.

6 Attach the new project to an email, or upload it to an accessible FTP or web server.

Note:  Some network servers may not recognize the native Final Cut Pro file format. To 
ensure that the file is properly transferred, you can create and send a compressed zip 
archive of your project instead.
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To create a cross-platform-compatible zip archive of your project(s):
1 In the Finder, select the Final Cut Pro project file(s).

2 Control-click the project file and choose Create Archive Of from the shortcut menu.

If you create a single archive zip file, the archive file will be named after the file you 
originally selected (for example, My Movie.fcp becomes My Movie.fcp.zip). If you select 
multiple files, the archive file will be named Archive.zip. You can change the name after 
the archive file is created, but keep the three-letter .zip extension at the end of the file 
name. This will help network servers properly handle the file.

The recipient will open the project and reconnect the media, which should match the 
settings you chose.

Even if you aren’t sure what settings the other person’s media files are set to, you can 
send the recipient your project without using the Media Manager. When the recipient 
gets the project, he or she can perform the same Make Offline media management 
operation explained above to create a project compatible with his or her local media files.

File 
transfer Low resolution

media files

High resolution
media files

Make offline in  
Media Manager

Make offline in  
Media Manager

File 
transfer

Desktop 
Editing System

ClipClip Clip

Project

ClipClip Clip

Project

PowerBook 
Editing System
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2 Editing and Trimming

The Timeline and Trim Edit windows in Final Cut Pro HD have been refined to allow 
even more specific control of your editing operations.

Copying and Pasting Clips in the Timeline
When you copy clips from tracks in the Timeline, Final Cut Pro pastes those clips in the 
same tracks unless you specify different destination tracks by clicking their Auto Select 
controls. If no Auto Select controls are clicked between copying and pasting clips, the 
pasted clips are placed on the same tracks from which they were copied.

Note:  Copying and pasting in the Timeline behaves differently in Final Cut Pro HD than 
in Final Cut Pro 4.1 and earlier.

To copy and paste clips within the same Timeline tracks:
1 Select one or several clips in the Timeline.

2 Copy the clips by pressing Command-C.

3 Paste the clips by pressing Command-V.

Copied clips Pasted clips
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To copy and paste clips from one Timeline track to another:
1 Select one or several clips in the Timeline.

2 Copy the clips by pressing Command-C.

3 Option-click the lowest numbered Auto Select control to select the track (or lowest 
track) you want to paste to.

4 Paste the clips by pressing Command-V.

V2 is auto selected
after copying clip.

No auto select controls
are changed after

copying clip.

Video clip is 
pasted to auto-
selected track.

Audio clips 
are pasted to 
original tracks.
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For example, to copy and paste clips from tracks V3, A5, and A6 to tracks V2, 
A2, and A3, do the following:

1 Select the clips on V3, A5, and A6.

2 Copy the clips by pressing Command-C.

3 Option-click the track V2 Auto Select control.

The video destination track for pasting is now set to V2.

4 Option-click the track A2 Auto Select control to set the lowest audio paste destination 
tracks.

The lowest numbered audio destination track for pasting is now set to A2.

5 Paste the clips by pressing Command-V.

Track V2 becomes
the pasting destination
after it is auto selected.

Track A2 becomes the
pasting destination

after it is selected.
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Filling a Timeline Gap With Slug
In Final Cut Pro 4.0 and earlier, filling a Timeline gap with slug performed a fit-to-fill 
operation, applying a constant speed change to the slug. In Final Cut Pro 4.1 and later, 
choosing the Fill with Slug shortcut command uses as many two-minute slug 
generators as necessary to fill the gap.

Adding Edits on Auto-Selected Tracks
The Add Edit command (Control-V) in the Sequence menu works like the Razor Blade 
tool, adding an edit point to all clips in the Timeline at the current position of the 
playhead. This command works on all tracks with Auto Select turned on.

Asymmetrical Trimming
Asymmetrical trimming allows you to simultaneously ripple edit opposing video and 
audio edit points in opposite directions. One common reason to do this is when 
creating split edits on two adjacent clips, but this feature can also be used with audio-
only and video-only clips.

Asymmetrical trimming can be done either in the Timeline or in the Trim Edit window.

Note:  If you are doing a lot of asymmetrical trimming, you may find it helpful to turn off 
the linked selection option by pressing Shift-L or clicking the Linked Selection control in 
the upper-right corner of the Timeline. For more information about linked selections, see 
Volume II, Chapter 6, “Editing in the Timeline,” in the Final Cut Pro 4 User’s Manual.
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To trim an edit asymmetrically to create a split edit (when the linked selection 
option is turned off ):

1 Select the Ripple tool.

2 Hold down the Option key, then click the Out point of an outgoing video clip to select it.

Holding down the Option key while selecting an edit point selects only that point, 
ignoring any other items linked to that clip.

3 Hold down the Command key, then click the In point of an incoming audio clip.

Holding down the Command key while selecting an edit point allows you to add edit 
points to the current selection without deselecting previously selected edit points.

Note:  In this example, Command-clicking the In point of a stereo pair audio clip results 
in adding both audio items to the selection. You can also Command-Option-click a 
single audio item to add it to the selection individually, without including other audio 
items linked to it. This can be especially useful for clips in which many audio items are 
linked to a single video item in the Timeline.

Out point of
outgoing video clip

In point of
incoming audio clips

Intended video
edit point
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4 Use the Ripple tool to trim the above selection.

Each opposite set of edit points moves in opposite directions, allowing you to create a 
split edit. Audio/video synchronization is maintained in both clips.

Applying Filters to Multiple Tracks
When you apply a filter to a clip in a sequence, the filter is applied to all clips in tracks that 
have Auto Select turned on, just as if you’d used the Range Selection tool. However, filters 
are applied to the entire clip regardless of whether In and Out points are set.

Dynamic Trimming in the Trim Edit Window
The Trim Edit window has a Dynamic checkbox that you can use to toggle dynamic 
trimming on and off, without having to go to the User Preferences window. This 
checkbox is located at the bottom of window, between the –1 and +1 Trim buttons.

Choosing Incoming and Outgoing Clips in the 
Trim Edit Window
In the Trim Edit window, you can activate the outgoing or incoming clip by moving the 
pointer over it. The play button on the active Trim Edit viewer is highlighted. JKL keys 
only affect the currently active clip.

Outgoing video clip
is trimmed shorter
from its Out point.

This clip remains
the same length.

Incoming audio clip
is trimmed shorter
from its In point.

This clip remains
the same length.
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Listening to Sequence Audio While Trimming
When trimming footage in the Trim Edit window, the following options are available in 
the Editing tab of the User Preferences window:
• Trim with Sequence Audio:  Allows you to listen to all sequence audio tracks while 

trimming in the Trim Edit window.
• Trim with Edit Selection Audio (Mute Others):  Mutes all audio tracks except the ones 

currently selected in the Timeline.

If both checkboxes are deselected, you will hear only the selected audio clips in the 
Timeline, including linked audio clips. This was the default trimming behavior in 
Final Cut Pro 4.0 and earlier.

Tip:  In most situations, you will want to keep the Trim with Sequence Audio checkbox 
selected. If you want to hear only specific audio tracks while trimming, select Trim with 
Edit Selection Audio (Mute Others).

Note:  When you launch Final Cut Pro for the first time, the Trim with Sequence Audio 
checkbox is selected by default.

Listening to All Sequence Audio Tracks While Trimming
Even if you are only trimming video clips, you may want to hear all of the audio tracks 
in your sequence, such as music, sound effects, and voiceover. This can be useful if you 
are listening for a particular audio cue to determine when to make a cut. 

To listen to sequence audio while trimming:
1 Choose Final Cut Pro > User Preferences and click the Editing tab.

2 Select the Trim with Sequence Audio checkbox.

Listening to Only the Selected Audio Tracks in the Sequence 
While Trimming
You may have a sequence with dialogue, sound effects, and music tracks but you 
currently want to focus on trimming only the dialogue and associated video. In this 
case, it helps to listen only to the currently selected video and audio clips while 
trimming, instead of the full audio mix of the sequence.

To hear only the selected clips in the Timeline while trimming in the Trim Edit 
window:

1 Choose Final Cut Pro > User Preferences and click the Editing tab.

2 Select Trim with Edit Selection Audio (Mute Others).

3 If necessary, select the Trim with Sequence Audio checkbox.
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Changing View Options in the Timeline Track Layout Menu
The Track Layout menu includes five additional options. These options can also be set 
in the Timeline Options tab of the Sequence Settings window. 
• Show Video Filmstrips
• Show Audio Waveforms
• Show Through Edits
• Show Duplicate Frames
• Show Clip Labels (not available in the Timeline Options tab)

To choose an option in the Track Layout menu:
m Open the Track Layout menu (the arrow next to the Track Height control), then choose 

an option. 

A checkmark next to a setting indicates that it is on. Choose the option again to 
remove the checkmark.

Detecting Duplicate Frames Over Transitions
When Show Duplicate Frames is turned on in a sequence’s settings, duplicate frames 
that occur over the duration of a transition between two clips are indicated by white 
dots to the left and/or right of that transition. The side of the transition the dots appear 
on indicates the clip or clips that use duplicate frames.

If you use a clip more than once within a single edited sequence, the duplicated frames 
are marked by a colored bar appearing at the bottom of the clip’s video item in 
the Timeline. 

However, if the duplicated frames fall outside the boundaries of the clip in the Timeline 
or fall within a transition, a special indicator—four white dots—appears where the 
duplicate frames are located. When you zoom out, the white dots decrease in range 
from four to zero, depending on the zoom level. 

The white dots indicate duplicate
frames used in a transition.

The red bars indicate duplicate 
frames used within a sequence.
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3 Using LiveType Titles 
in Final Cut Pro

You can directly import LiveType project files into Final Cut Pro HD. This eliminates the 
need to render a QuickTime movie of your LiveType title each time you want to use it in 
Final Cut Pro.

Note:  To open LiveType projects directly in Final Cut Pro, LiveType 1.2 or later must be 
installed on the Final Cut Pro system you are using.

To import a LiveType project into Final Cut Pro, do one of the following:
m Choose File > Import or Command-I and navigate to the LiveType project you want to 

import into Final Cut Pro.
m From the Finder, drag a LiveType project file into the Final Cut Pro Browser.

The LiveType project file appears as a clip in the Final Cut Pro Browser.

A LiveType project file within Final Cut Pro is simply referred to as a LiveType clip or a 
LiveType movie. If necessary, you can reconnect the media (in this case, the actual 
LiveType project file on disk) just as you would any other Final Cut Pro clip.

Using LiveType Clips in Final Cut Pro
In Final Cut Pro, imported LiveType project files behave just like any other clips. They 
can be organized within the Browser, opened in the Viewer, edited into sequences, 
trimmed, copied, and pasted. LiveType clips maintain normal master and affiliate clip 
relationships.

Playing LiveType Titles in Final Cut Pro
LiveType titles can be played back in Final Cut Pro like any other media file. However, 
when edited into sequences, LiveType clips appear with a red render bar in the 
Timeline, so you will have to render those portions of your sequence.
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Editing the LiveType Title Contents
Although you can perform normal editing tasks with a LiveType clip, the LiveType title 
contents cannot be adjusted directly within Final Cut Pro. LiveType title settings can 
only be changed in the LiveType application. Final Cut Pro provides a quick and easy 
way to open LiveType clips directly in the LiveType application to make changes to 
your title.

To automatically open a LiveType clip from within Final Cut Pro:
1 In the Final Cut Pro Browser or within a sequence, Control-click the LiveType clip in which 

you want to adjust title settings, then choose Open in Editor from the shortcut menu.

The LiveType project file is automatically opened in the LiveType application.

2 In LiveType, make any necessary changes to the LiveType title.

3 Save and close the LiveType project file.

4 Return to Final Cut Pro.

Final Cut Pro automatically relinks any LiveType clips that reference the LiveType project 
you just changed. In Final Cut Pro, you can immediately see the changes to the 
LiveType title. Using this method, you do not need to reconnect the LiveType project 
file each time you alter it outside of Final Cut Pro.

Note:  The Creator column in the Final Cut Pro Browser indicates what application is 
launched when you choose Open in Editor from a clip’s shortcut menu. For LiveType 
clips, the creator is automatically set to LiveType.
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4 Editing Film With Final Cut Pro 
in a PAL Environment

New Support for Conforming 25 fps to 24 fps 
and Exporting 25 fps EDLs
Final Cut Pro now provides features that let you conform 25 fps (PAL) media to 24 fps, 
edit at 24 fps, and export a 25 fps EDL. This is for situations in which your content 
originated on film and your negative cutter prefers to receive a 25 fps EDL from you 
instead of a film cut list. In order to allow you to edit at the same speed as the film, and 
yet export an accurate 25 fps EDL for the negative cutter, the 25 fps timecode is 
maintained while the editing timebase of your sequence is 24 fps.

The new features that make this possible include:

• A DV PAL 24 @ 25 Easy Setup and DV PAL 48 kHz - 24 @ 25 sequence preset
• A “Conform 25 to 24” command in the Tools menu
• The ability to export a 25 fps EDL from a 24 fps sequence
• A new source timecode rate called 24 @ 25

Note:  If your negative cutter prefers to receive a cut list rather than an EDL, use 
Cinema Tools to create a clip database from the telecine log or ALE file and to conform 
the clips to 24 fps. Then, you can export a cut list (called a film list) from your edited 
sequence in Final Cut Pro. See the Cinema Tools documentation for more information 
on creating databases and exporting film lists.
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The 25 fps EDL Export for Film Workflow
The basic steps involved in this workflow are outlined below. Refer to the Final Cut Pro 
and Cinema Tools documentation if you need more information about certain 
procedures mentioned here.

Step 1:  Film at 24 fps and transfer to PAL video
Transfer your 24 fps film to 25 fps PAL video. The film is sped up to 25 fps in the 
telecine transfer.

Step 2:  Use Cinema Tools to generate a batch capture list for Final Cut Pro
This is an optional step, but if you have a telecine log from a scene-and-take transfer, 
using Cinema Tools to create the batch capture list makes it easy to automatically 
capture clips with the cuts that were chosen in the scene-and-take transfer. It would be 
more time consuming to find and capture the clips manually with Final Cut Pro. 

Step 3:  In Final Cut Pro, choose the Easy Setup called DV PAL 24 @ 25
If you don’t see the DV PAL 24 @ 25 Easy Setup in the pop-menu in the Easy Setup 
dialog, choose Show All. This Easy Setup sets the sequence preset editing timebase to 
24 fps, while the sequence source timecode is tracked as 25 fps. (This is called having a 
24 @ 25 source timecode rate.) It also lets you import your 25 fps batch capture list and 
capture at 25 fps.

Note:  The DV PAL 24 @ 25 Easy Setup uses the DV PAL 48 kHz - 24 @ 25 sequence 
preset. If you are not using DV video, you can create a custom Easy Setup by editing 
the DV PAL 24 @ 25 Easy Setup. Customizing the preset allows you to:

• Capture a format other than DV
• Incorporate a custom sequence preset that has an editing timebase of 24 fps and a 

timecode rate of 25 @ 25

Step 4:  Capture the PAL video with Final Cut Pro
The DV PAL 24 @ 25 Easy Setup that you chose in the previous step ensures that you 
capture your video at its PAL frame rate of 25 fps even though the editing timebase is 
set to 24 fps.
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Step 5:  Select the clips in the Browser, then choose Tools > Conform 25 to 24
This command adjusts the PAL clips to play at a frame rate of 24 fps. (This command 
has the same effect as conforming from 25 fps to 24 fps in Cinema Tools.)

Note:  If your clips contain both audio and video, the Conform 25 to 24 command also 
adjusts the audio speed so that the audio and video remain in sync after the frame rate 
is changed. If the audio is separate and not contained in the source clips, an additional 
step is needed to sync the audio and video clips and merge them together as one clip 
in Final Cut Pro before editing.

Step 6:  Edit the project in Final Cut Pro
You are editing at 24 fps, the same rate at which the film was shot, so the video and 
audio are not sped up (as they were in the telecine transfer).

Step 7:  Select the sequence and export an EDL for the negative cutter
When you export an EDL for this sequence, Final Cut Pro creates a 25 fps-based EDL. Now 
you can give the EDL to your negative cutter, who can then create a cut list from it.

Final Cut Pro creates EDLs based on the source timecode rate of the project, not the 
video frame rate (or editing timebase). In most cases, the source timecode rate and 
video frame rate are the same, but 24 @ 25 fps clips are an exception. For this reason, 
your sequence needs to have 24 @ 25 as its timecode rate (as set by the Easy Setup in 
Step 3) in order to export a 25 fps EDL.

There is a new Browser column called TC Rate, which you can look at to confirm that your 
clips have a 24 @ 25 timecode rate. If you don’t see this column in the Browser, Control-
click a Browser column heading, then choose TC Rate from the shortcut menu. You can 
also set the source timecode rate to 24 @ 25 by using the Modify > Timecode command.

For more information about modifying timecode, see “Modifying Media File and 
Sequence Timecode” on page 88.

Important:  You cannot accurately recapture offline clips that have been conformed 
from 25 fps to 24 fps. Also, do not use the Media Manager to make the clips offline, or 
to delete clips or unused media after conforming from 25 fps to 24 fps. If you need to 
capture these clips again, repeat the capturing and conforming steps (steps 3 through 
5 above).
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Some Background About Working With 24 @ 25 in Final Cut Pro
When you conform PAL video from 25 fps to 24 fps, the result is that the clips play at 
24 fps in actual time. This means the speed appears natural and normal as you are 
editing—it’s the same speed at which the original material was filmed. But the 24 @ 25 
timecode you see displayed by Final Cut Pro is counting 25 fps. It shows a new timecode 
second starting after the frame numbered “:24” by the timecode, even though in actual 
time the new second starts after the frame marked “:23” by the timecode. The picture 
below illustrates an example of this. Notice that though the same frames in both columns 
are played at different actual times, they still have the same timecode associated with 
them, as highlighted by the frames at timecode 01:00:00:23. 

How can it be that the timecode counts at 25 fps while the editing timebase of your 
sequence is 24 fps? For one thing, the timecode track stored within the source media 
file did not change—it is still 25 fps—even though the source media video rate was set 
to play at 24 fps. And, when you conformed the PAL video from a 25 fps to a 24 fps 
rate, no frames were actually added or taken away. What changed is that the frames 
were slowed down to play a little later in actual time, while the 25 fps timecode count 
did not change. This makes the most sense if you think of timecode in this situation as 
simply a sequential labeling mechanism instead of a time-tracking mechanism. For 
example, in actual time, the frame labeled “01:00:00:23” plays later than it did before, so 
the number “01:00:00:23” no longer conveys how much actual time has passed. It is 
now simply a unique label to identify that frame.

Most importantly, regardless of how fast or slow the video plays in Final Cut Pro, the 
source timecode associated with each frame in Final Cut Pro still corresponds to the 
timecode for those same frames on the source media tapes. This allows an accurate 
25 fps EDL to be exported from the sequence.

PAL video timecodeFrame Frame
0 second
actual
clock time

25 fps PAL video

01:00:00:00

01:00:00:01

01:00:00:02

01:00:00:03

01:00:00:20

01:00:00:21

01:00:00:22

01:00:00:23

01:00:00:24

01:00:01:00

Timecode shown in Final Cut Pro

Conformed to 24 fps

01:00:00:00

01:00:00:01

01:00:00:02

01:00:00:03

01:00:00:19

01:00:00:20

01:00:00:21

01:00:00:22

01:00:00:23

01:00:00:24

01:00:01:02 01:00:01:01

01:00:01:01 01:00:01:00

1 second
actual
clock time
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Note:  Importing a 25 fps EDL for editing at 24 fps is not supported. A 25 fps EDL needs 
to be imported into a 25 fps sequence. You cannot create and edit a 24 fps sequence 
from a 25 fps EDL. In other words, the 24 @ 25 fps EDL editing process only works in 
one direction:  from film to PAL tape to 25 fps EDL.

Viewing the Clip Time (24 fps) Versus the Source Time (25 fps)
The 25 fps timecode that is displayed in Final Cut Pro when you edit 24 @ 25 fps media 
is called the source time, since it is the timecode information encoded in the source 
media files. However, as described above, the 24 @ 25 fps video is played at 24 fps in 
actual time, so the source time you see is different from the actual time in which the 
clips are played, which is called the clip time. For more information on this topic, see 
“Displaying Timecode in Final Cut Pro” on page 83.

If you would prefer to edit your 24 @ 25 fps clips with Final Cut Pro displaying 24 fps 
timecode instead of 25 fps timecode, do the following:

m Open a clip in the Viewer, then Control-click the Current Timecode field and choose 
Clip Time from the shortcut menu.

Note:  Keep in mind that this setting only changes the way Final Cut Pro displays the 
timecode for your project. Internally, Final Cut Pro still tracks the source timecode as 
25 fps so that you can export an accurate 25 fps EDL that will be used to create a 
negative cut list.

Exercises for Understanding 24 @ 25 fps Timecode
Thinking about a movie in which the video frame rate and the timecode rate don’t 
match can be confusing. If you find yourself going in circles trying to understand 
exactly how the frame rate and timecode rate correspond (or don’t correspond) to each 
other, it’s important to step back and remember the overall purpose of the 24 @ 25 
editing process.

Even if the concept is a bit confusing, the process works if you carefully follow the steps 
explained in “The 25 fps EDL Export for Film Workflow” on page 74.

The Purpose of 24 @ 25 fps Editing
24 @ 25 fps editing allows you to edit film footage at its native 24 fps frame rate using 
Final Cut Pro and inexpensive PAL video equipment. This means you can edit film 
nonlinearly at a very low cost.

After you finish editing, European film negative cutters expect a 25 fps EDL which is 
used to conform the original film negative to your final video edit.

The 24 @ 25 editing process achieves both these goals.
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If you are still grappling with the frame rates and timecode counting rates that don’t 
match, you can try the following exercises to better understand this principle. To do 
these exercises, you need only the following items:

• A pen and paper
• A clock or watch that increments in seconds

Tip:   Your computer clock can easily be set to count in seconds. To set your computer 
clock to count in seconds, see the instructions on page 81.

Once you have a clock counting in seconds, you are ready to begin.

Exercise 1:  Counting 60 numbers (0 to 59) each minute
1 At the turn of a minute (when the second counter reaches zero), begin writing down 

the number of seconds passed on the clock.

Your paper should look something like this:

0 1 2 3 4 5... and so on.

Note:  At first, it may be challenging to write numbers this quickly and also keep in sync 
with the clock. It’s okay if you scribble a few of the numbers, as long as you make some 
kind of mark for each second that passes. If some of the numbers are scribbled, you can 
usually go back and fill them in based on the numbers you successfully wrote down.

After you reach 59, the minute counter on the clock increments by one and the second 
counter resets to zero.

2 During the next minute, continue writing down the number of each second, but add a 
1 before each number.

Your numbers should now look like this:

... 57  58  59  1 0  1 1  1 2  1 3  1 4... and so on.

If you can write fast enough, you might add a colon (:) for clarity, like this:

1:0  1:1  1:2  1:3  1:4... all the way to 1:59.

Note:  If writing the colons slows you down, skip them. The instructions will continue to 
show them for clarity.

3 Continue writing numbers during the next minute, this time adding the number 2 
before each second counted, like this:

1:57  1:58  1:59  2:0  2:1  2:2  2:3  2:4... and so on.

No matter how messy your writing is, make sure that you write a unique number at 
each and every second that is counted on the clock. That is the most important part of 
the exercise.

4 Stop writing after three or four minutes.
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You can now determine exactly how long you were writing simply by looking at the 
last number you wrote on the paper. As unremarkable as this sounds, this is exactly 
how timecode works:  A unique number is written alongside each video frame as long 
as the video is recording.

Note:  Although timecode and video frames move much faster—many times per 
second—the process is identical to the exercise above.

So far, this experiment has only revealed how regular timecode works. To make things 
more interesting, you can do the same experiment again but with a subtle twist. This 
time you’ll have to pay a little more attention while you write the numbers, but should 
be able to catch on after a few tries.

Exercise 2:  Counting 59 numbers (0 to 58) each minute
Instead of counting 60 numbers during each minute (from 0 to 59), now you will use 
only 59 numbers (from 0 to 58). The steps below explain how.

1 Just as before, at the turn of a minute (when the second counter reaches zero), begin 
writing down the number of seconds passed on the clock.

Note:  If you like, you can add a 0:0 (a zero, a colon, and a zero) before each second to 
make your numbers look more consistent. As usual, skip the colon if it slows down 
your writing. Just make sure you write something unique for each second that passes 
on the clock.

Your numbers should look like this:

0:00  0:01  0:02  0:03  0:04  0:05... 0:55  0:56  0:57 0:58...

2 Here is the subtle twist in the exercise. When you reach 0:58, the next number you 
should write is 1:00, not 0:59. The number :59 is never allowed in this exercise because 
you are now counting from 0 to 58, not 0 to 59.

If you slip up the first time, start the exercise over at step 1. It will be easier to do this 
the second time once you anticipate this subtle difference.

The numbers on your paper should look like this:

... 0:55  0:56  0:57  0:58  1:00 1:01 1:02

3 Continue writing numbers during the next minute:

... 1:03  1:04  1:05  1:06...  1:55 1:56 1:57  1:58...

4 Again, when you reach the :58 in the count, it’s time to increment the leading number 
(the minute marker) from 1 to 2.

1:55 1:56 1:57  1:58  2:00  2:01  2:02  2:03... 

5 Continue writing for several minutes, even if you think you are doing the exercise 
poorly. The most important thing to do is make some kind of mark for each second 
that passes on the clock and to avoid the number :59 in your counting (as explained 
above). Don’t stop until you have written for a minimum of three minutes.
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The reason this exercise is challenging is because you have to keep track of the count 
on paper or in your head and ignore the numbers on the clock. The first minute is easy. 
After that, if you simply copy the numbers on the clock’s second counter, you won’t be 
doing the exercise properly. The first problem with copying the numbers you see on 
the clock counter is that you will eventually include the :59, which isn’t allowed. The 
other, more challenging problem is that each minute that you skip another :59, your 
number count on paper drifts further and further from the clock’s number count.

One way to make the exercise easier is to use a clock or metronome (a musical beat 
counter) that flashes 60 times per minute, but doesn’t show an actual number count. 
This way, the numbers on the clock won’t throw you off, but a steady beat (rate) is 
provided to keep you counting in proper time.

Even if you can’t easily complete the second exercise, make sure you always make 
some kind of mark on the paper for each second that passes. This is the most critical 
thing to do, so that each second of actual time that passes is accounted for on your 
piece of paper, no matter how scribbled it may have been written.

The second exercise demonstrates an important concept:  No matter what you write on 
paper, you are always writing at a rate of 60 times per minute. The only difference 
between the first and second exercise is not how fast you wrote (it was the same rate 
in both cases:  60 times per minute), but what you wrote, since you used a different 
counting method in each exercise.

At the end of the first exercise, looking at the last number immediately tells you how 
long you were writing. For example, if the last number you wrote was 3:14, you know 
that you were writing for 3 minutes and 14 seconds. However, in the second exercise, if 
the last number you wrote was 3:14, it would be incorrect to say you were writing for 
3 minutes and 14 seconds because you actually skipped a couple of numbers along the 
way. Since you skipped 0:59, 1:59, and 2:59, the numbers written on paper are 
3 seconds ahead of where the actual clock time was at. In other words, 3:14 on your 
paper means you were only writing for 3 minutes and 11 seconds. More importantly, 
the numbers themselves don’t correspond to how much time passed, but each second 
is accounted for because you wrote something at each second.
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Relating these exercises back to video with frame rates and timecode counts that don’t 
match, imagine that the seconds you were accounting for were actually frames of film 
or video. Each mark you made would then indicate a frame passing. The frames pass at 
a constant rate (such as 24 fps) and are each labeled with a unique identifier (or code). 
When the unique codes are counting at the same rate as the frames pass, it’s easy to 
tell how much time has passed simply by reading the unique code, or timecode, on a 
particular frame. However, when the unique identifier increments differently than the 
frame rate, the code on each frame no longer accurately represents how much time 
has passed. This is what happens when playing 24 fps video with unique frame codes 
counting at 25 fps. Each frame has a unique label, but reading them doesn’t accurately 
convey how much actual time has passed.

To set your computer clock to display seconds:
1 Click the clock displayed on the right side of the menu bar.

A menu with the following choices appears:

• View as Analog
• View as Digital
• Open Date & Time

2 Choose View as Digital.

3 Click the clock again and choose Open Date & Time from the menu.

The Date & Time System Preferences window opens.

4 In the Date & Time System Preferences, click the Clock tab.

5 If it’s not already selected, select the checkbox labeled “Display the time with seconds.”

The clock in the menu bar now shows time counting in seconds.

6 Choose System Preferences > Quit System Preferences or press Command-Q.
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5 Viewing and Modifying Timecode

Timecode is the vital organizational link between your original camera tapes, media 
files on disk, and clips in Final Cut Pro. When you prepare for the final cut, each editing 
decision you made in an earlier phase must be accurately traced back to the original 
camera masters via timecode.

Final Cut Pro HD displays timecode information differently than in earlier versions.

Displaying Timecode in Final Cut Pro
Final Cut Pro provides flexible options for viewing timecode in the Viewer, Canvas, 
Timeline, and Browser. This flexibility covers a varied range of editing scenarios, many 
of which may not apply to your particular footage. If the timecode display choices 
seem overwhelming, it’s best to stick with the Final Cut Pro default settings:
• Time mode:  Source Time
• View Native Speed:  Selected

If you need to change the timecode viewing mode for a particular clip, only that clip 
will be affected. Other clips, including affiliate clips, will not be affected.

Frame Rate Versus Timecode
The frame rate of a piece of film, videotape, or media file determines how quickly 
frames are recorded or played back. Timecode (or edge code in the case of film) is a 
unique address for each frame, providing easy navigation, logging, recapturing, and 
final edit decision lists (EDLs) that accurately refer back to original camera reels.
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Timecode Modes
For each clip, you can select one of two timecode modes:
• Source time:  The timecode track of the media file
• Clip time:  Timecode based on the frame rate of the current clip

Source Time
Source time refers to timecode addresses of your media file. Because you usually refer 
back to the original source tapes at some point during your project, Final Cut Pro 
displays source time by default.

Source Timecode Tracks
If your media file has several timecode tracks, you can also choose which source 
timecode track to display when viewing source time:
• Source timecode
• Aux 1 timecode
• Aux 2 timecode

If the current media file does not have auxiliary (Aux) timecode tracks, there are no 
timecode track options in the timecode field shortcut menu. Only source time and clip 
time are available in this case.

Auxiliary timecode tracks are often used to synchronize separate film and sound media 
files which are recorded with independent timecode tracks. Adding auxiliary timecode 
tracks allows you to add new timecode to your media file without overwriting the 
original timecode.

Clip Time
Clip time allows you to view timecode based on the frame rate of the media file instead 
of the rate of the timecode track. This is useful when the frame rate and timecode rate 
of a media file don’t match.

For example, if you are editing 23.98 fps (24p) video that came from 29.97 fps tapes, the 
frame rate of your media files is 23.98 fps but the timecode runs at 30 fps. To see 24 fps 
timecode that matches the video frame rate, choose clip time.

Another example is when you are editing 24 fps clips that came from 25 fps tapes 
(called 24 @ 25). In this case, you can choose to look at the original 25 fps timecode 
(source time) or have Final Cut Pro display 24 fps timecode (clip time).

Important:  Clip time does not necessarily correspond to the timecode of the source 
media file timecode. Do not rely on clip time when trying to refer back to original 
frames from media files or tapes.

Note:  For most editing situations, there is no difference between source time and clip 
time. To avoid confusion, you should usually select source time unless you have a 
specific reason to use clip time.
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Time Displays
You can also choose to view your timecode with several possible time displays, 
depending on the frame rate of the media file:
• Non-Drop Frame:  Available for most frame rates
• Drop Frame:  Available only for 29.97 fps (NTSC) media files
• 60 @ 30:  Available only for 60 and 59.94 fps (high definition) media files
• Frames:  Available for any frame rate

Time display merely affects the way the timecode numbers count, whereas source 
time, clip time, and View Native Speed actually adjust the rate (or speed) of the 
timecode. In general, it’s best to choose a timecode mode first, then choose the time 
display that suits your particular editing scenario.

To change the timecode display format:
m Control-click a timecode field in the Viewer, Canvas, Timeline, or Browser, then choose 

one of the available timecode display options from the shortcut menu.

All video frame rates can be displayed as a straight frame count, and exclusively use 
non-drop frame counting. Counting in frames is particularly useful for animated films or 
time lapse sequences.

29.97 fps NTSC video is the only video format that can display a drop frame count.

Important:  You cannot modify media file timecode by changing the time display.

Timecode Affected by Speed Settings
To see timecode affected by speed adjustments to the current clip, select View Native 
Speed. The word native indicates that you are seeing the timecode numbers directly 
from the media file without any interpretation from Final Cut Pro.

If View Native Speed is selected, the timecode is affected by speed settings (if any) 
applied to the current clip. For example, if your clip has been slowed down by 50%, the 
timecode numbers increment at 50% speed as well.

Important:  The timecode numbers are italicized to indicate that a clip’s speed has been 
adjusted. Timecode numbers display in italics only when View Native Speed is selected.

If View Native Speed is deselected, the timecode will count at its normal rate, 
unaffected by any speed settings applied to the current clip.

Note:  In Final Cut Pro 4.1 and earlier, the only way to view timecode adjusted by a clip’s 
speed setting was to choose clip time. In Final Cut Pro HD, clip time does not interpret 
clip speed settings. Instead, the View Native Speed selection shows timecode affected 
by speed settings, regardless of whether source time or clip time mode is chosen.
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Unless you make speed adjustments to a clip, switching this setting on and off won’t 
have any noticeable effect on the way timecode displays.

Important:  Adjusting speed affects how a clip plays back the frames of a media file, but 
it does not affect the frames of the media file itself. Constant and variable speed 
adjustments are nondestructive—they leave the media file intact.

To see how speed settings affect the timecode view, try the following:
1 Open a clip in the Viewer.

2 Choose Modify > Speed or press Command-J.

3 Type 25% in the Speed number box and click OK.

The clip now plays back frames from the media file at 25% speed. The source timecode 
plays back just as slowly.

4 In the Viewer, move through the clip one frame at a time using the left and right 
arrow keys.

Note that the timecode numbers change once every four frames. This is because the 
speed-adjusted clip holds each video frame for a duration of four frames. Therefore, the 
video frames and the timecode numbers only change every fourth frame when viewed 
in the speed-adjusted clip.

5 Control-click the current timecode field, then deselect View Native Speed from the 
shortcut menu.

Note:  When View Native Speed is deselected, the timecode field is no longer italicized.

6 In the Viewer, move through the clip one frame at a time using the left and right 
arrow keys.

Final Cut Pro now increments the timecode at the frame rate of the clip, ignoring any 
speed adjustments.

If you want to see the actual source timecode of each frame of the media file, leave 
View Native Speed selected.

Timecode Overlays
Timecode overlays in the Viewer and Canvas display source time (not clip time) from 
the media file. Timecode overlays are not affected when clip time is selected or View 
Native Speed is deselected.

You can use timecode overlays to verify that video “window burn” timecode (visible 
timecode in the video picture itself ) matches the source timecode of the media file.
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Each timecode overlay is colored to indicate linked video and audio clips. A + (plus) 
symbol next to the video or audio overlay title indicates that there are additional 
timecode overlays that cannot fit. Changing the size of the Canvas or Viewer can 
sometimes reveal additional timecode overlays.

Globally Changing Timecode Display Options
Timecode display settings can be globally adjusted for an entire project in Project 
Properties. Clips that you have already adjusted will retain custom timecode 
display settings.

To choose default timecode display options for the active project:
1 In the Browser, click the tab of the project for which you want to change timecode 

display settings.

2 Choose Edit > Project Properties.

3 Choose a new timecode display from the Time Display pop-up menu.

4 Click OK.

Indicates additional
timecode overlays
are not displayed.
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To reset the timecode display for all clips in the active project:
1 In the Browser, click the tab of the project that you want to change timecode display 

settings for.

2 Choose Edit > Project Properties.

3 Choose a timecode display from the Time Display pop-up menu.

4 Select the Reset Time Display checkbox.

5 Click OK.

To globally set the time mode of all clips in the project to source time, clip 
time, and native speed on or off:

1 In the Browser, click the tab of the project for which you want to change time 
mode settings.

2 Choose Edit > Project Properties.

3 Choose a source time or clip time from the Time Mode pop-up menu.

4 Select or deselect the View Native Speed checkbox.

5 Click OK.

Modifying Media File and Sequence Timecode
In Final Cut Pro 4, you can modify media file timecode in several ways:
• Individual timecode adjustments can be made by choosing Modify > Timecode.
• Multiple clips can be adjusted in the Browser column.

Timecode tracks in your media files can be added, altered, and even removed by 
choosing Modify > Timecode. This is the most common way to add or delete timecode 
tracks from a media file.

When modifying clips that refer to several media files (such as merged clips), there is a 
tab for each media file in the Modify Timecode dialog.
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Each media file or sequence can have up to three timecode tracks and corresponding 
reel names:

• Source timecode track and reel name
• Aux 1 timecode and Aux 1 reel name
• Aux2 timecode and Aux 2 reel name

Note:  Depending on the frame rate of the media file, some timecode rates may not 
be allowed.

Some timecode settings can be modified in the Browser or Item Properties, but other 
settings are restricted to prevent accidental changes. When you modify particular 
Browser columns, Final Cut Pro will warn you that the media file, not just the clip within 
the project file, will be affected.

The new TC Rate item property (visible in both the Browser columns and Item 
Properties), shows the source timecode rate of clips and sequences. Only the source 
timecode rate is displayed, not Aux 1 or Aux 2 timecode rates. Use the TC Rate Browser 
column to adjust the timecode rate for many clips at once. Some timecode rates are 
not allowed for some video frame rates.

Note:  TC Rate refers to the rate of a media file or sequence timecode track. Vid Rate 
refers to the frame rate of the video itself.

In general, choosing Modify > Timecode provides deeper control over your timecode 
modifications, but the Browser allows you to modify multiple clips at once.

Timecode modification Using Modify > Timecode Using Browser

Adding or deleting timecode 
tracks in a media file

Allowed Not allowed

Modifying timecode
(Media Start)

Allowed on any clip Allowed only with offline clips 
not associated with media files

Modifying reel names
(Reel, Aux 1 Reel, Aux 2 Reel)

Allowed Allowed with warning

Modifying timecode rate
(TC Rate)

Allowed Allowed

Choosing source time timecode 
track (TC)

Unavailable Allowed. Control-click the 
TC field.

Viewing different timecode 
display formats

Allowed Allowed. Control-click any 
timecode field.
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Note:  You can only adjust Media Start and Media End fields in the Browser or Item 
Properties for offline clips that are not associated with media files.

For more information about modifying timecode, see Volume II, Chapter 17, “Tools for 
Managing Clips,” in the Final Cut Pro 4 User’s Manual.

Sequence Settings and Timeline Options
The starting timecode number of a sequence can be modified in the Sequence Settings 
window. To modify the timecode rate of the sequence, you need to use the Modify > 
Timecode command.

To adjust the starting timecode number of a sequence:
1 Select a sequence in the Browser or make a sequence active by selecting the Canvas or 

Timeline window.

2 In the Sequence Settings window, click the Timeline Options tab.

3 Type a new timecode number in the Starting Timecode number field.

4 Click OK.

In special editing scenarios, the video rate (timebase) and timecode rate of a sequence 
need to be different. For example, if you are editing 24 @ 25 film-to-PAL video, you use 
a sequence with a frame rate of 24 fps with a timecode track modified to 25 fps.

For more information about the 24 @ 25 PAL editing process, see “Editing Film With 
Final Cut Pro in a PAL Environment” on page 73.

To create a sequence preset in which the video rate (timebase) and timecode 
rate are different:

1 Choose Final Cut Pro > Audio/Video Settings.

2 Click the Sequence Presets tab.

3 In the list of presets, click the unlocked sequence preset you want to modify.

4 Click the Edit button to edit the selected preset, or click the Duplicate button to edit a 
new copy of the selected sequence preset.

The sequence video frame (timebase) and timecode rate can now be set in the Sequence 
Preset Editor window. By default, the timecode rate matches the video frame rate, as 
indicated by the words Same As Editing Timebase in the Timecode Rate pop-up menu.

5 Choose a video frame rate from the Editing Timebase pop-up menu.

Warning:  Modifying or deleting your source timecode track or reel name may make 
recapturing from source tapes impossible and EDLs inaccurate. Unless you have a 
good reason for modifying the source timecode track, it’s best to leave the timecode 
captured from tape.
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6 Choose a timecode rate from the Timecode Rate pop-up menu.

Note:  Not all timecode rates are available for all video rates (timebases).

7 Click OK to accept the changes and click OK again to close the Audio/Video 
Settings window.

The new sequence preset can be loaded into preexisting sequences or used in Easy Setups.

If you already have a sequence for which you’d like to modify the timecode rate, you 
can also use the Modify > Timecode command. However, it’s usually best to alter the 
timecode rate of a sequence before you begin editing with it.

To modify the timecode rate of a preexisting sequence:
1 Select a sequence in the Browser.

2 Choose Modify > Timecode.

3 Adjust, add, or remove timecode tracks as needed.

For more information about modifying timecode tracks, see Volume II, Chapter 17, 
“Tools for Managing Clips,” in the Final Cut Pro 4 User’s Manual.

High Definition and Film Timecode Options
Final Cut Pro provides several special timecode formats for dealing with particular high 
definition video formats and offline film-to-video workflows.

60 @ 30 Timecode
60 @ 30 timecode is used specifically with 59.94 and 60 fps material. Because 30 fps is a 
more universally accepted timecode rate than 60 fps, it can be useful to view your 
timecode this way. Also, most DVCPRO HD VTRs display this timecode rate when 
playing back 60 fps tapes. Each 60 @ 30 timecode number represents a pair of video 
frames, with the second frame distinguished by an asterisk (*).

When you are using 60 @ 30 timecode, Final Cut Pro recognizes asterisks when you 
type them into timecode fields. Typing + followed by * in 60 @ 30 mode is the same as 
typing +1 in 60 fps timecode.

Mapping 60 frames to 30 numbers per second is not a new concept. VITC timecode 
represents each pair of fields (in other words, each frame) with a single timecode 
number. Fields 1 and 2 are distinguished by an asterisk placed on field 2. 
60 @ 30 timecode works similarly.

Warning:  It is not a good idea to choose an independent video rate (timebase) and 
timecode rate for your sequence unless you have a good reason.
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24 @ 25 Timecode
24 @ 25 timecode displays 25 fps timecode while you are editing 24 fps video.

For more information about 24 @ 25 fps editing, see “Editing Film With Final Cut Pro 
in a PAL Environment” on page 73.

Generating Timecode Window Burns
In Final Cut Pro HD, timecode reading and generation are separated into two filters, 
replacing the Timecode Print filter. Both are located in the Video category of the Video 
Filters bin in the Effects tab.

Timecode Reader
The Timecode Reader generates a visible timecode counter based on the clip or 
sequence frame rate (timebase) to which the filter is applied.

Timecode Generator
The Timecode Generator generates a visible timecode counter independent of the 
timebase and timecode format of the affected clip (or sequence). For example, you can 
apply a Timecode Generator filter counting at 24 fps while the affected sequence has a 
timebase of 29.97 fps.

The Timecode Generator now supports 60 fps and 60 @ 30 fps time display. For more 
information about 60 @ 30 timecode, see “720p60 and 60 @ 30 fps Timecode” on 
page 49.

To generate a visible timecode “window burn,” apply the Timecode Reader 
filter to one of the following:
• Individual clips
• An entire sequence

To apply the Timecode Reader filter to an entire sequence:
1 Nest your original sequence within a second sequence with matching sequence settings.

2 Within the second sequence, apply the Timecode Reader filter to the nested, 
original sequence.

Note:  Older projects that use the Timecode Print filter will still function properly.
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6 Media and Clip Management

Edit to Tape and Print to Video
In some instances, Edit to Tape and Print to Video used to require re-rendering of 
material in the Timeline prior to output. In Final Cut Pro HD, re-rendering is no longer 
necessary, significantly reducing rendering time before output.

Note:  Built-in countdowns, slates, color bars, and tone still require rendering before output.

Automatically Recording With Print to Video
When printing to video tape, Final Cut Pro can automatically trigger recording on 
FireWire camcorders and decks.

This is particularly useful for camcorders that do not have an independent VTR Record button.

To automatically start a camcorder or deck recording during Print to Video:
1 Choose File > Print to Video.

2 Select the Automatically Start Recording checkbox in the Print to Video window.

3 Click OK to begin recording to tape.

Note:  The Automatically Start Recording checkbox is the same as the Auto Record and 
PTV checkbox in the Device Control presets.

Setting Minimum Allowable Space on Scratch Disks
Each time Final Cut Pro generates a new preference file, the Minimum Allowable Free 
Space On Scratch Disks number field is calculated based on a percentage of the first 
scratch disk selected in the Scratch Disks tab of the System Settings Preferences.

The minimum allowable disk space depends on whether the disk is currently a boot volume 
(the drive with the currently running operating system) or a non-boot volume:

• If the first scratch disk selected is a boot volume, 5% of the total drive capacity is 
automatically entered.

• If the first scratch disk selected is a non-boot volume, 1% of the total drive capacity is 
automatically entered.

You can adjust this value as needed.
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Maximizing Media File Performance for Multiple Stream, 
Real-Time Playback
Final Cut Pro captures and writes media files to maximize the number of simultaneous 
streams and real-time effects during playback.

Note:  The number of playback streams does not necessarily correspond to the number 
of video tracks in your sequence. Instead, the number of streams refers to how many 
simultaneous video files can be read from your scratch disk.

In rare cases, Final Cut Pro alerts you if imported media files cannot be optimized for 
multiple-stream, real-time playback. These files are perfectly fine to use in your 
Final Cut Pro project. Unless you are editing with multiple uncompressed video streams 
that demand maximum media file performance, you can usually leave the files as they 
are and continue editing normally. Since Final Cut Pro always optimizes files when 
capturing, simply recapturing should maximize the file’s performance.

Note:  If you are editing standard definition DV captured in Final Cut Pro, your media 
files are already optimized.

Final Cut Pro may not automatically optimize the following:

• Media files captured or created with a third-party codec not supported by Final Cut Pro
• Some media files captured in early versions of Final Cut Pro

To disable the non-optimized media warning when importing files into 
Final Cut Pro:

1 Choose Final Cut Pro > User Preferences.

2 Click the General tab.

3 Deselect the “Warn when importing non-optimized media” checkbox.

Final Cut Pro will no longer warn you when it discovers a media file that it cannot 
automatically optimize.

Determining the Application That Created a Clip
The Creator item property (visible in both the Browser columns and Item Properties) 
shows the name of the application that created the media file referenced by a clip.

Creating Duplicate Master Clips in the Browser
To create a new master clip instance of a clip in the Browser, press Option while 
dragging a clip from the Timeline into the Browser, then press Command. When you 
see a pointer with M+ next to it, this indicates that a new master clip is being created; 
you can release the keys.
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Changing Affiliate Clips Into Independent Clips
As a result of the relationship between master and affiliate clips, changes made to 
certain properties of a master clip, such as Clip Name, Reel Name, or Timecode are 
automatically made to all affiliated clips within the current project. These same 
changes, if made to an affiliate clip, are also made to that clip’s master clip, as well as to 
all other affiliated clips in the current project.

The online or offline state of clips is also automatically updated among all affiliated 
clips in a project, all at once. Suppose you open a project in which all the clips are 
offline. Relinking that project’s master clips in the Browser automatically relinks all the 
affiliate clips that appear in each of that project’s sequences.

Depending on your project, you may choose to sever an affiliate clip from its master. This 
prevents the affiliate clip from updating with its master clip and other affiliate clips.

To make an affiliate clip in a sequence independent:
m Control-click the affiliate clip in the Timeline, then choose Make Independent Clip from 

the shortcut menu.

Your affiliate clip is now an independent clip. Any changes you make to this clip do not 
affect the master clip.

Removing Subclip Limits
As a result of the relationship between master and affiliate clips, changes made to 
certain properties of a master clip or subclip are automatically made to all affiliated 
clips within the current project. The same is true of subclips and any affiliates 
associated with them. 

In particular, if you extend the In and Out points on a subclip to those of the original 
master clip, your subclip now has all of the media in the original master clip. Therefore, 
if you remove the limits from one subclip, Final Cut Pro removes the limits from all 
other subclips associated with it.

Automatic Naming of Captured Clips
Automatic naming of captured clips in Final Cut Pro has been updated to remove extra 
zeroes from the beginning of a clip number. For example, in previous versions of 
Final Cut Pro, a series of clips would automatically be named and numbered as 
follows:  Untitled 0001, Untitled 0002, Untitled 0003. The extra zeroes in front of the 
number ensured that the clips would remain in sequential order once the clips reached 
0010 and 0100 respectively. Final Cut Pro no longer requires the extra zeroes in order to 
sort effectively. Now clips are automatically named and numbered as follows:  Untitled, 
Untitled 2, Untitled 3.
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Additional Settings in the Batch Capture Window
In the Batch Capture window, when you select the Use Logged Clip Settings checkbox, 
additional settings are included for the captured clips:
• Image and Gain settings (for analog capture)
• Capture settings from the Capture pop-up menu
• Audio settings from the Audio Format pop-up menu

These settings are found in the Clip Settings tab of the Log and Capture window.

Display of Items in the Render Manager
Items in the Render Manager are now displayed in three groups:  audio, audio 
mixdown (sequence level audio render files), and video.

Including Master Comment Information in EDLs
When you export an EDL, you can now choose to export Master Comments 1–4 or 
Comment A–B in the EDL Export dialog. These appear as notes in the EDL, letting 
offline editors give notes to the online editor about complicated entries on the list.
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7 External Audio and Video 
Monitoring

Seeing and hearing your project on external monitors and speakers can provide a more 
accurate sense of your final project than simply using the built-in computer speakers 
and display. Since all Final Cut Pro systems can send video and audio out of the built-in 
FireWire connector, it is easy to monitor the Canvas or Viewer on an external NTSC or 
PAL monitor. Some editors may choose to monitor their video and audio signals using 
third-party digital video and audio cards.

External Monitoring Setups
Your external monitoring setup will vary depending on the scale and budget of your 
editing system.

To configure and select external video and audio outputs:
1 Choose Final Cut Pro > Audio/Video Settings.

2 Click the A/V Devices tab.

3 Choose a video device or port from the Playback Output video pop-up menu.

4 Choose an audio output device or port from the Playback Output audio pop-up menu.

For more information about specific setups, see the description of common external 
monitoring setups below.

FireWire DV

Audio

FireWire Composite
or S-video

Computer

DV camcorder
in VTR mode

NTSC/PAL
monitor

Amplified speakers
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A FireWire DV setup is a common configuration. The FireWire device (either a 
camcorder, VTR, or FireWire-to-analog converter box) converts DV signals to video and 
audio signals connected to a video monitor and self-powered speakers. If you have a 
home stereo system, you can also connect the audio output of the FireWire device into 
any available channels on the home stereo system.

FireWire video and USB or FireWire audio

Using a FireWire or USB audio interface is an alternative to a DV-only setup. This 
configuration can potentially handle more than two discrete audio channels and may 
feature better digital-to-analog converters (depending on the interface). Most FireWire 
audio interfaces have more audio channels than USB (1.1) interfaces.

Uncompressed video via FireWire using the AJA Io

The AJA Io is set up just like a standard DV setup using FireWire, but instead of using 
compressed DV signals, the Io transfers an uncompressed component 4:2:2 signal. The 
full Io unit supports SDI and analog outputs for analog or digital monitoring. There are 
four analog audio outputs for monitoring via speakers.

USB or
FireWire

Audio
interface

Audio

FireWire Video

Computer

DV VTR

NTSC/PAL
monitor

Amplified speakers

NTSC/PAL
monitor

Audio

FireWire Video

Computer

Amplified speakers

AJA lo
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Using a Computer Display for External Video Monitoring
Final Cut Pro allows you to monitor Canvas or Viewer video using a computer display, 
simplifying your video editing system setup. If you have two computer displays, one 
can be used to view the Final Cut Pro interface and the Finder while the other can be 
used as a dedicated video monitor.

Although this setup works for any video format, it can be particularly useful when 
editing high definition video that would otherwise require a fairly expensive HD 
monitor. Progressive video formats such as 720p are well suited for monitoring on a 
computer display.

Note:  If you are doing critical online editing or color correction, you may still want to 
use an external CRT video monitor, especially when your final output is interlaced 
broadcast video.

The following external video monitoring choices are available:

Desktop (Normal)
The video is not scaled unless it is too large to fit on the display. If the video signal is 
larger than the display, it is scaled to fit on the display.
• Pros:  The video always maintains proper aspect ratio and does not exhibit scaling 

artifacts due to magnification.
• Cons:  Some formats, especially SD formats, may look very small when displayed on 

large computer displays.

USB or
FireWire

Amplified speakers

Computer
Display

(Final Cut Pro)
Display

(External video)

Audio
interface
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Full-screen
The video is scaled to fit the display in at least one dimension. If the aspect ratio of the 
video signal and the computer display do not match, the video on the display is 
letterboxed (black on top and bottom) or pillarboxed (black on sides) as necessary.
• Pros:  This format gives you the biggest picture possible and maintains the proper 

aspect ratio.
• Cons:  Scaling artifacts may be noticeable when viewed up close.

Raw (1:1)
This mode shows the video data with as little processing as possible. This can be useful 
for engineering evaluations of the image. No scaling is done whatsoever.
• Pros:  More accurate assessments of video quality can be made.
• Cons:  Not useful for general viewing. No scaling or pixel aspect ratio adjustments are 

made, even when the video is larger than the display.

Note:  For example, a 720p frame (1280 x 720) showing in raw mode on an 800 x 600 
display only shows 800 x 600 of the image.

To view Final Cut Pro video output on a computer display connected to your 
computer:

1 Choose Final Cut Pro > A/V Settings.

2 Click the A/V Devices tab.

3 Choose one of the display options from the Playback Output Video pop-up menu.

4 To listen to audio in sync with video output on a computer display, make sure the 
audio frame offset value is set to 0. For information about how to set the frame offset 
for audio/video latency compensation, see “Compensating for Latency With Frame 
Offset” on page 101.

Challenges With External Monitoring
No matter what method you use for external monitoring, all digital video and audio 
output cards (including FireWire) introduce inherent processing delays (known as 
latency) to signals sent out of the computer. External video and audio coming from the 
built-in FireWire port or third-party interface may be several frames later than the video 
on your computer display (in the Viewer or Canvas). The latency between external 
devices and the computer display and speakers can be confusing, especially when you 
are doing precise editing.
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Compensating for Latency With Frame Offset
By changing the frame offset, you can compensate for the delay between your 
computer display and external video and audio outputs. Frame offset is active only 
when your sequence real-time effects are handled by Final Cut Pro. For information 
about setting the Effects Handling tab of the Sequence Settings window, see Volume I, 
Chapter 6, “Viewing and Setting Preferences,” in the Final Cut Pro 4 User’s Manual.

To set the frame offset between the computer display and the external video 
and audio outputs:

1 Choose Final Cut Pro > System Settings.

2 Click the Playback Control tab.

3 Enter an amount (in whole frames) in the Frame Offset number field.

Frame offset can be any whole number between 0 and 30. The default value is 4. For 
example, if a video monitor connected to your DV camcorder shows your program 4 
frames later than your computer display, a frame offset of 4 will synchronize the two.

Note:  Depending on your external monitor configuration, you may need to experiment 
with frame offset values to synchronize the external monitor and the computer display.

4 Click OK.

5 In the Canvas or Viewer, play and compare the video offset between your external 
monitor and your computer display.

6 If the computer display and external monitor are still not synchronized, repeat steps 1 
through 5 using different frame offset values until the display and monitor are in sync.

Note:  Final Cut Pro automatically compensates for latency in third-party audio cards if 
proper Mac OS X CoreAudio drivers are provided.
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High Definition Video 
Fundamentals

Television is undergoing a radical change—the most fundamental redesign since its 
invention nearly 100 years ago. Everyone working in television, video, and even film 
production has heard the news:  The switch from analog to digital television is 
underway. Television is being shot, edited, and even broadcast all in the digital domain.

All-digital television requires new production formats, transmission guidelines, 
broadcasting equipment, television receivers, post-production workflows, and display 
devices. As more digital television services become available from major TV networks, 
more people are purchasing digital television receivers and display devices for home 
viewing. To understand how the industry has arrived at the digital formats of today, a 
historical perspective can be useful.

A Brief History of Film, Television, and Audio Formats
The timeline below helps to illustrate the constantly evolving list of media formats as 
well as developmental peaks and valleys.

Year Event

1826 First photograph is taken.

1877 Thomas Edison makes the first sound recording of “Mary had a little lamb.”

1888 Heinrich Hertz shows that electricity can travel through space and that radio waves are 
physically identical to light.

1889 35mm film is invented by splitting Eastman Kodak 70mm in half (1.33 aspect ratio).

1895 Marconi develops radio transmitter and receiver.

1895 Lumière brothers demonstrate combination camera/projector (16 fps).

1918 First color motion picture appears.

1920 Commercial radio broadcasts begin.

1923 16mm film is introduced.

1927 First major motion picture with sound is released (1.37 aspect ratio), ending the silent 
movie era.

1932 BBC begins official monochrome, 30-line video broadcast.
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1934 RCA experiments with 343-line, 30 fps television format, removing flicker by 
introducing interlacing.

1936 BBC begins broadcasting a high definition, monochrome, 405-line, 25 fps interlaced 
signal tied to European 50Hz electrical frequency.

1939 NBC begins regularly scheduled broadcasts of electronic television, 441 lines and 30 fps.

1941 National Television Systems Committee (NTSC) standardizes U.S. commercial television 
format, 525 lines, 30 fps tied to U.S. 60Hz electrical frequency.

1945 FCC allocates 13 channels for television broadcasting and moves existing radio channels 
to 88–108MHz.

1946 ENIAC, the first electronic computer, using 18,000 vacuum tubes, is unveiled.

1948 Long-playing (LP) phonograph records are introduced.

1948 Hollywood switches to nonflammable film.

1948 Ampex introduces its first professional audio tape recorder.

1948 The transistor is invented.

1951 The first commercially available computer, UNIVAC I, goes on sale.

1952 The FCC provides UHF channels 14 through 83.

1953 Second NTSC adopts RCA color-TV standard, 525 lines, 29.97 fps, interlaced.

1953 First CinemaScope, anamorphic film is released with 2.66 aspect ratio (1.33 x 2).

1955 Stereo tape recording is introduced by EMI Stereosonic Tapes.

1956 Ampex introduces its first video recorder using 2-inch reel-to-reel tape.

1961 Stereo radio broadcasts begin.

1963 Philips introduces audio cassette tapes.

1967 BBC TWO becomes the first British color broadcast network, using the PAL system, 
625 lines, 25 fps interlaced.

1967 France introduces SECAM, 625 lines, 25 fps, interlaced.

1967 The Society of Motion Picture and Television Engineers (SMPTE) standardizes timecode.

1968 The computer mouse is invented.

1970 3/4-inch U-Matic video format is introduced.

1970 Computer floppy disk is introduced.

1971 First permanent IMAX film system is installed.

1972 FCC establishes rules for cable TV.

1972 The first computer editing system, the CMX-300, is introduced.

1975 JVC introduces the Video Home System (VHS).

1977 First pre-assembled personal computer, the Apple II, is introduced.

1982 Sony, Fujitsu, and Philips introduce audio compact discs (CDs).

1986 BetacamSP is introduced.

1987 The first commercial digital videotape format, D-1, is introduced.

Year Event
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To fully appreciate today’s digital, high definition video formats, consider that some of 
the earliest television signals (circa 1930) had only 30 lines of resolution. In the 1940s, 
an electronic television system in Europe was introduced with such a remarkable 
increase in resolution—405 lines—that it was labeled high definition in comparison to 
the previous 30-line format. Soon after, the North American NTSC format was 
introduced using 525 lines. After significant industry debate, color was added to the 
NTSC signal using a method that maintained backward compatibility with the original 
black-and-white signal. (This was also the historical moment when the NTSC frame rate 
was subtly altered from 30 fps to 29.97 fps.) Overcoming the shortcomings of the NTSC 
color signal, European PAL and SECAM (France) color formats were introduced in the 
1960s using 625 lines.

Since the introduction of the standard definition television formats, digital technology 
has matured and global communications have proliferated via satellites and the 
Internet. At the beginning of the 21st century, a wave of digital television (DTV) 
standardization efforts merged with a rekindled interest in high definition electronic 
image acquisition. One of the results of these standardization efforts is the Advanced 
Television Standards Committee (ATSC) digital television standards. The ATSC specifies 
high definition television (HDTV) formats and digitally redefines traditional analog 
standard definition television (SDTV) formats.

Digital signals are more flexible than analog signals:  Frame rate and image dimensions 
are variable within a single tape format, and high data compression ratios mean 
excellent picture quality using a fraction of broadcasters’ allotted bandwidth. For 
television viewers, this means higher resolution images, higher frame rates, or several 
standard definition channels in the bandwidth of a single standard analog channel.

1990 General Instrument proposes an all-digital HDTV system in the U.S.

1991 Japan adopts Hi-Vision/MUSE as the national HDTV standard, 16:9 aspect ratio, 
1,125 scanning lines, 30 fps, interlaced.

1993 Digital Betacam is introduced.

1996 DV format is introduced.

1997 DVD format is introduced.

1997 Advanced Television Systems Committee (ATSC) digital television standards are 
adopted by FCC, including 18 formats, 6 of which are HDTV.

1999 Final Cut Pro 1.0 is introduced.

2000 DVCPRO HD equipment begins shipping.

Year Event
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ATSC Digital Television Formats
With the exception of Japan’s MUSE HDTV broadcast format and current HD 
development in Europe, HDTV today usually refers to the ATSC specifications. Unlike 
the single frame size and rate of the NTSC and PAL formats, the ATSC chose18 official 
digital television formats, and several of these have official designations from the 
Society of Motion Picture and Television Engineers (SMPTE). Broadcasters can use their 
currently allocated frequency spectrums however they choose. For example, a network 
may choose to show a single HD channel or two simultaneous SD channels.

The ATSC standards also introduced six high definition television standards. Though 
some experts define high definition video as any image with over 1000 lines, the 
general consensus is that both the1920 x 1080 and 1280 x 720 formats are high 
definition television (HDTV) formats. The smaller, older generation of analog and digital 
formats, generally referred to as standard definition (SD), are represented in the ATSC 
standards, as well as several SD widescreen (16 x 9) formats.

ATSC has also satisfied computer manufacturers with the option of a progressive 
scanning method. In the ATSC table below, the scanning method is labeled either 
interlaced (i) or progressive (p).

Related
SMPTE standard Dimensions

Frame rate and
scanning method

Aspect 
ratio

Pixel 
dimensions

SMPTE 274-1998 1920 x 1080 60i
30p
24p

16 x 9 Square

SMPTE 296M-2001 1280 x 720 60p
30p
24p

16 x 9 Square

SMPTE 293M-1996 720 x 480 or
704 x 480

60p 16 x 9 Rectangular

720 x 480 or
704 x 480

60i
30p
24p

16 x 9 Rectangular

720 x 480 or
704 x 480

60p
60i
30p
24p

4 x 3 Rectangular

640 x 480 60p 4 x 3 Square

SMPTE RS170A 640 x 480 60i 4 x 3 Square

640 x 480 30p
24p

4 x 3 Square
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Note:  The SMPTE RS170A standard actually specifies the color NTSC analog broadcast 
format in use since 1953, and only roughly corresponds to the ATSC 640 x 480/60i format. 

Each ATSC format also supports NTSC-speed variants:  23.98 (24), 29.97 (30), and 59.94 
(60), calculated by multiplying whole number frame rates by 1000/1001 (which is a 
slightly more accurate ratio than 29.97/30).

The Benefits of High Definition Video
High definition video formats are rapidly gaining acceptance in markets as varied as 
sports broadcast and high-end feature films. Aesthetically, HD video is exceptionally 
detailed and rich in color depth, and uses a widescreen aspect ratio similar to major 
motion pictures. Technically, HD video formats are less restrictive than the analog SD 
formats of the past. Because the latest formats are digital, the same physical videotape 
can be used to store several different image sizes, frame rates, and scanning methods 
with a simple flip of a switch. Even film cinematographers who once judged video 
inadequate for film-quality work are discovering the benefits of HD acquisition and 
postproduction without sacrificing image quality or the universal film frame rate (24 fps).

Here are some reasons why people choose high definition video as an alternative to 
standard definition (SD) video:

• HD has a 16 x 9, widescreen aspect ratio.
• HD has increased horizontal and vertical resolution compared to SD.
• Multiple frame rate choices make it possible to shoot footage that’s compatible with 

NTSC, PAL, or film.
• Progressive scanning eliminates interlacing artifacts (such as thin, horizontal line 

flicker) and creates movies compatible with computer displays.

Here are some reasons why people choose high definition video as an alternative to film:

• The high resolution images are comparable to film.
• Digital formats allow for lossless archive copies and generations of post-production 

processing such as color correction and image compositing.
• Footage can be watched immediately after shooting, removing lab processing time.
• Tape stock is cheaper than film stock, partly because there are no additional lab 

processing costs.
• Longer recording times are possible on videotape than on film reels.
• An all-video post-production pipeline eliminates costly and time consuming film 

scanning and output stages compared to hybrid digital film methods.
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High Definition Versus Standard Definition Video Formats
Whenever a new format is introduced, it needs to be distinguished from the formats 
that already exist. Standard definition video wasn’t a commonly used term until the 
latest high definition formats were introduced a few years ago.

High definition has two slightly different meanings. Generally speaking, the term high 
definition describes any image or sound format that is higher resolution than another 
format. Today, high definition (HD) also specifically refers to high definition video 
formats such as HDCAM, DVCPRO HD, HDV, and the current ATSC HDTV specifications.

High Definition Formats in Common Use
Every major video manufacturer is developing high definition technology. As a result, 
many different formats are available to choose from.

24P Video
Formats that capture complete (progressive) video frames at 24 frame per second have 
received a lot of attention lately. This is because 24p video specifications are similar to film 
standards. A 24 fps,1920 x 1080, progressively scanned video format closely matches 
35mm film theater distribution prints. For the first time since the invention of television, 
moviemakers can choose video instead of film without sacrificing significant resolution 
loss or having to cope with frame rate conversions. Now that the technology is available, 
which medium to use has become more of an aesthetic and budgetary choice.

Scanning Methods
Most high definition formats can record both progressive and interlaced video.
• Interlaced scanning:  Odd lines are first drawn onscreen (called field 1), followed by 

the even lines (field 2) to complete a single frame.
• Progressive scanning:  Every line is scanned until a complete frame is drawn. There are 

no fields.

24psF
Some HD equipment uses a third method to store progressively captured camera 
images within an interlaced structure on tape. This format is called progressive 
segmented frame (psF), and it is usually discussed in reference to 24p video.

This method cleverly adapts existing1080i50 video (1080 interlaced lines running at 50 
fields per second) to 1080i48, using both fields to store a single progressive frame. 
While this could be called1080p24, it’s technically 1080psF because each progressive 
frame is stored on tape as two interlaced fields that were actually captured from the 
camera CCD at the same time.
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Compressed High Definition Tape Formats
Because of the high data rate generated by high definition video cameras, most HD 
formats compress the image data to fit on tape.
• DVCPRO HD (SMPTE D-12); also generally called DV-100 in reference to its bit-rate of 

100 Mbps.
• D-9 HD, an extension of the Digital S format. (Digital S is also designated SMPTE D9.)
• D-5 HD, an extension of the D-5 format
• HDCAM and HDCAM-SR (an extension of the HDCAM format)

Uncompressed High Definition Tape Formats
High definition requires extremely high data rates (around 1.5Gb/sec.). There are no 
camcorder (in which the recorder is built into the camera) formats currently available 
for recording uncompressed HD video. High-capacity, general-purpose digital tape 
formats like D-6 can be used in combination with camera heads and digital telecine 
machines capable of outputting uncompressed RGB and component HD video data. 
High-speed disk arrays can also be used to record uncompressed HD video.

A Comparison of Common High Definition and Standard 
Definition Formats
The table below shows the relative data rates of some commonly used high 
definition formats.

Format Bits per second (video only) Bytes per second

DVCPRO HD, 1080i60 100 Mbps 11.75 MB/sec.

DVCPRO HD, 1080i50 100 Mbps 11.75 MB/sec.

DVCPRO HD, 720p60 100 Mbps 11.75 MB/sec.

DVCPRO HD, 720p30 50 Mbps 11.75 MB/sec.

DVCPRO HD, 720p24 40 Mbps 11.75 MB/sec.

D-5 HD 210 Mbps 26.25 MB/sec.

DV 25 Mbps 3.6 MB/sec.

DVCAM 25 Mbps 3.6 MB/sec.

DVCPRO(25) 25 Mbps 3.6 MB/sec.

DVCPRO 50 50 Mbps 6.25 MB/sec.

Digital Betacam 95.2 Mbps 11.9 MB/sec.

D-1 172 Mbps 21.5 MB/sec.
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Discussing HD Formats in Conversation
Because there are so many possible HD formats, it’s best to be as specific as possible 
when describing a particular variant. Always mention the image dimensions, frame 
rate, and scanning method.

Often, people in the film and video industries abbreviate HD format names to either the 
frame rate or image dimensions (but not both) with the scanning method tagged on to 
the end (for example, 24p or 1080i). The letter i indicates an interlaced scanning method, 
and the letter p indicates progressive scan. Sometimes, formats are abbreviated because 
they are being discussed categorically instead of specifically. 24p is commonly discussed 
as video at the film frame rate, but does not go into details such as the image dimensions 
or the actual frame rate, which could be either 24 fps or 23.976 fps.

Eventually, you’ll memorize the various frame rates and image dimensions of the 
common HD formats, as well as better understand the contexts in which they are 
discussed. Meanwhile, the examples below may help you get started distinguishing HD 
formats discussed in the film and video industries.

Determining Frame Rate From Image Dimensions
The following example suggests ways of assessing the frame rate of an HD video 
format when only an image dimension is used in the name.

1080i refers to a frame size of 1920 x 1080, and the i indicates that the frames are 
interlaced. But what is the frame rate?

Since the frame rate isn’t specifically expressed in the name 1080i, you can usually 
determine the frame rate based on the particular brand of HD format or the context in 
which the format is being used.

1920 x 1080 DVCPRO HD can only be recorded at 29.97, 30, or 25 fps, so the country and 
specific camera used can most likely determine which frame rate is implied (29.97 fps 
for NTSC, 25 fps for PAL).

If the context of the conversation involves shooting film, it’s likely that the frame rate 
for a 1920 x 1080 image is 23.98 or 24 fps (and consequently the format would not be 
DVCPRO HD, since 24 fps is not currently supported at 1920 x 1080 using this format).

UP01022.Book  Page 110  Tuesday, March 23, 2004  7:32 PM



Appendix     High Definition Video Fundamentals 111

 

Determining Image Dimensions From Frame Rate
The following example suggests ways of assessing the image dimensions of an HD 
video format when only the frame rate is given in the name.

24p describes an image recorded progressively at either 23.98 or 24 fps. But what are 
the image dimensions?

If you are using DVCPRO HD, only frame sizes of 1280 x 720 support 23.98 and 24 fps 
recording. Some standard definition DV and DVCPRO 50 cameras can also record 
progressive frames at 23.98 fps, using image dimensions of 720 x 480.

Other HD cameras can record 23.98 or 24 fps with image dimensions of 1920 x 1080, 
but these cameras often use 24psF (progressive frames segmented stored in an 
interlaced signal structure). See “24psF” on page 108 for a description of this format.

Upconverting and Downconverting
To fully experience the quality of HD video, a complete HD system is necessary:  HD 
camcorders, tape formats, editing systems, broadcasting services, and finally, HD 
televisions and receivers. Because HD systems are still relatively new, many video 
producers find that they need to combine HD with SD footage, or several HD sizes, 
within the same project.

Converting a video format to a higher resolution format is called upconverting and the 
reverse is called downconverting. However, the process of upconverting and 
downconverting is not as simple as scaling a video frame. Changes in aspect ratio, 
mostly between 4 x 3 (standard definition) and 16 x 9 (high definition) are also part of 
the process.

Some reasons you may need to convert between HD and SD or vice versa are:

• If you are working on an HD project using archival footage (which is still mostly 
standard definition)

• If you have finished editing an HD program and you need a distribution copy in a 
standard definition format like Digital Betacam, DV, DVD, or VHS

• If you are combining high definition footage such as a feature film transfer into an 
SD project

The most common scenarios are upconverting SD footage for use in an HD sequence 
and downconverting HD projects to SD distribution formats, which clearly 
demonstrates that HD is becoming a prevalent mastering format.
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Downconverting High Definition Video
The method used in downconverting HD video depends on the destination format and 
the intentions of the cinematographer or director. Since 16 x 9 images don’t fit within a 
4 x 3 frame, some cinematographers shoot widescreen images while protecting for 
another aspect ratio. For example, 16 x 9 protected for 4 x 3 will keep the majority of 
the action centered within a 4 x 3 portion of the 16 x 9 image. This footage can be 
safely cropped for a 4 x 3 version as well as a 16 x 9 version.

Of course, if the aspect ratio of the original and destination formats match, you can 
simply scale the original HD video to the destination size.

Letterbox

Original 
size

Original
aspect ratio

Destination 
size

Destination
aspect ratio

Downconversion 
method

1920 x 1080 16 x 9 (1.78) 1280 x 720 16 x 9 (1.78) Scale down

1920 x 1080 16 x 9 (1.78) 720 x 480
(anamorphic)

16 x 9 (1.78) Scale down 
and squeeze 
horizontally

1920 x 1080 16 x 9 (1.78) 720 x 480 4 x 3 (1.33) Letterbox
Crop
Pan and scan

1280 x 720 16 x 9 (1.78) 720 x 480
(anamorphic)

16 x 9 (1.78) 
squeezed

Scale down 
and squeeze 
horizontally

1280 x 720 16 x 9 (1.78) 720 x 480 4 x 3 (1.33) Letterbox
Crop
Pan and scan

720 to 480

1080 to 480
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To preserve the aspect ratio of widescreen movies on a 4 x 3 screen, widescreen movies 
are scaled until the entire image fits within the 4 x 3 frame. The remaining space at the 
top and bottom of the 4 x 3 frame is left empty, and is almost always made black. If a 
film or video was shot to be exclusively viewed in a widescreen venue, this technique is 
usually the best approach for downconversion. However, it has the disadvantage of 
poorly using the vertical resolution of the 4 x 3 frame, which is already lower resolution 
to start with.

Cropping

If you are careful during production to keep both aspect ratios in mind, making sure 
important action stays within the 4 x 3 center of the 16 x 9 frame, you can choose to 
crop your entire movie within a 4 x 3 frame (or a 14 x 9 frame, sometimes used in 
Great Britain). This method allows you to fill the whole 4 x 3 screen with some portion 
(usually the center) of your 16 x 9 image. This simple crop can be applied to the entire 
film without significantly altering the visual storytelling.

For broadcast in the UK, 16 x 9 images are often cropped to 14 x 9 and letterboxed 
within a 4 x 3 frame (for standard definition PAL televisions). Because a 14 x 9 image has 
less severe letterbox (that is, smaller black bars at the top and the bottom of the frame), 
some viewers find this less objectionable.

16 x 9 to 4 x 3
crop center

16 x 9 frame 4 x 3 frame
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Pan and Scan

The pan and scan method also crops 16 x 9 movies within a 4 x 3 frame, but the movie 
can be cropped on a shot-by-shot basis. This is a more time-consuming approach to 
converting 16 x 9 to 4 x 3, but it is often necessary when the original widescreen movie 
was not shot with 4 x 3 in mind. This is often the case with older widescreen movies 
shot prior to mass video rental and distribution, since the only viewing venue was in 
movie theaters capable of showing the complete widescreen images.

In some complex scenes with multiple characters or centers of visual activity, you may 
have to introduce an artificial camera move (a pan) to recenter the widescreen action 
within the 4 x 3 frame. Unless this is done subtly, the viewer may be distracted by the 
unnatural movement.

Note:  Use the panning technique only when absolutely necessary, and make sure the 
frame rate of the pan you are introducing matches the frame rate of the movie itself.

16 x 9 to 4 x 3
pan and scan
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Upconverting Standard Definition Video
Upconverting a 4 x 3 aspect ratio image in a 16 x 9 frame results in borders (or side 
panels) on the left and right sides of the 4 x 3 image. This type of frame is sometimes 
referred to as pillarboxed.

If the aspect ratio of the original and destination formats match, you can simply scale 
the original video to the destination size.

4 x 3 anamorphic video is actually a 16 x 9 image squeezed into a 4 x 3 frame, so it can 
easily be scaled to fit a high definition sequence.

Original
size

Original
aspect ratio

Destination
size

Destination
aspect ratio

Upconversion
method

720 x 480 4 x 3 (1.33) 1280 x 720,
1920 x 1080

16 x 9 (1.78) Scale up and 
pillarbox

720 x 480
(anamorphic)

16 x 9 (1.78)
squeezed

1280 x 720,
1920 x 1080

16 x 9 (1.78) Scale up

1280 x 720 16 x 9 (1.78) 1920 x 1080 16 x 9 (1.78) Scale up

480 to 720

480 to 1080

480 anamorphic 
to 1080

480 anamorphic 
to 720
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DVCPRO HD Specifications
DVCPRO HD is an extension of the DVCPRO (25) and DVCPRO 50 formats.

DVCPRO HD Tape Format
The data rate of DVCPRO HD is fixed at 100 megabits per second, or 12.5 megabytes per 
second. The tape speed of DVCPRO HD is double the DVCPRO 50 tape speed and four 
times the speed of DVCPRO.

DVCPRO, DVCPRO 50, and DVCPRO HD use a metal particle (MP) tape formulation. 
Some tape sizes are supported only by decks and not by cameras. As the data rate is 
doubled from 25 to 50 to 100 Mbps, the recording time is halved in each case. 
Therefore, a 63-minute DVCPRO tape stores only 31 minutes of DVCPRO 50 footage, or 
15 minutes of DVCPRO HD.

Aspect Ratio
Regardless of the specific resolution used, DVCPRO HD always captures and displays an 
image with an aspect ratio of 16 x 9 (or 1.78).

Warning:  DV (sometimes referred to as miniDV) and DVCAM use a metal evaporated (ME) 
tape formula while DVCPRO uses metal particle tape. When in doubt, always use cassettes 
explicitly manufactured for the camera or VTR you intend to use the tapes with.

Widescreen cinema
2.35:1

Standard cinema
1.85:1

High definition
1.78:1

(16 x 9)
DVCPRO HD

Standard
definition

1.33:1
(4 x 3)
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Interlaced and Progressive Scanning Methods
DVCPRO HD can record either interlaced or progressive scan images, depending on the 
frame size and format.
• 1920 x 1080:  Interlaced, also called 1080i
• 1280 x 720:  Progressive, also called 720p

When choosing a scanning method, keep in mind the following:

• Progressive frame rates are compatible with computer monitors, eliminating 
interlacing difficulties that motion graphics designers and special effects artists faced 
for years.

• Interlaced CRTs are still the predominant television display throughout the world. All 
major television systems (PAL, NTSC, and SECAM) are interlaced, as is the current 
Japanese HDTV format Hi-Vision/Muse.

Native Image Dimensions
DVCPRO HD cameras capture two possible Common Image Format (CIF) image 
dimensions:
• 1920 pixels x 1080 pixels
• 1280 pixels x 720 pixels

Or, here this is described using traditional analog terminology:

• 1080 lines, each sampled 1920 times
• 720 lines, each sampled 1280 times

Although a DVCPRO HD camera CCD (charge coupled device) captures full resolution 
HD images, every two or three pixels are averaged together—a process known as 
subsampling—so that less pixel information is recorded to tape.

Therefore, the native image dimensions of DVCPRO HD are:

• 1080 lines, each sampled 1280 times, or 1280 pixels x1080 pixels (60i)
• 1080 lines, each sampled 1440 times, or 1440 pixels x 1080 pixels (50i)
• 720 lines, each sampled 960 times, or 960 pixels x 720 pixels (720p)

The resulting subsampled pixels are sometimes called rectangular pixels, a concept 
that often leads to some confusion.

1280 x 720

720 x 480

1280 x 1080

1920 x 1080

1440 x 1080

1920 x 1080

720p 480i, 480p1080i60 1080i50

960 x 720
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The reason DVCPRO HD internally uses rectangular pixels is to reduce the overall 
amount of data recorded to tape and disk, but you shouldn’t need to worry about 
these behind-the-scenes format details while you shoot or edit. An HD SDI signal 
output from an HD VTR or camera has square pixels, a welcome relief for video graphics 
designers after struggling to understand standard definition rectangular pixels.

Note:  Standard definition digital formats were originally designed to create a single 
digital format capable of sampling both NTSC and PAL 720 times per line. To fit both 
576 lines (PAL) and 480 or so lines (NTSC) while using a consistent number of samples 
(720) per line, rectangular pixels (or pixels that represent rectangular portions of the 
screen) must be used. ITU-R 601 (formerly referred to as CCIR 601), was first 
implemented in the D-1 tape format in 1986. All component digital SD formats have 
since adopted this approach, including DV, DVCAM, DVCPRO, D-5, Digital Betacam, 
Digital S (D-9), DVD, and so on. Unlike the DVCPRO HD pixels which actually subsample 
and reduce the amount of overall data, SD video records and shows all the pixels.

Color Depth and Video Sampling Rate
DVCPRO HD records component Y'CBCR color, sampling at a component ratio of 4:2:2. 
Each sample (pixel) is recorded natively at 8-bit. FireWire transfers color natively at 8-bit 
color depth, and HD SDI transfers each color sample as a10-bit value.

Frame Rate
DVCPRO HD is capable of recording and playing back all the ATSC specified frame rates 
as well as a PAL-compatible frame rate. In practice, the NTSC-related frame rates are 
used far more often than the integer rates.
• Integer frame rates:  60, 30, and 24 fps
• NTSC-related frame rates:  59.94, 29.97, and 23.98 fps
• PAL-related frame rate:  25 fps

Note:  25 fps 1080i video cannot be adjusted to an NTSC-related frame rate.
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Versatile Formatting Choices With Digital Formats
Storing video digitally allows versatile formatting choices while still using the same 
physical storage media. Frame rate, image dimensions, and scanning methods are no 
longer rigidly defined per tape format.

For example, the same DVCPRO HD camcorder and tape can be used to record a 
1920 x 1080 interlaced image at 29.97 fps or a 1280 x 720 progressive scan image at 
59.94 fps. The equation is simple:  Higher resolution images require more data, so the 
frame rate must be lower. The reverse is also true:  Higher frame rates require more 
data; therefore, the image dimensions must be smaller. As long as the combination of 
frame rate, image dimensions, and number of audio channels does not exceed the tape 
or disk data rate, a wide range of format choices is available within a single tape format.

Note:  While many HD formats allow you to record different frame sizes and frame rates on 
the same videotape, you should avoid this. Some video decks may have to be powered on 
and off to switch between formats, making tape playback unnecessarily inefficient.

One second

Smaller frames,
more frames
per second

Larger frames,
fewer frames
per second
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DVCPRO HD Timecode
DVCPRO HD records timecode at 30 fps for NTSC-related frame rates or 25 fps when 
recording at 25 fps. When recording a video at 59.94 or 60 fps, each timecode number 
actually is used twice, with an asterisk used to distinguish frame 1 and frame 2 of each 
timecode pair. Using 30 fps timecode maintains backward compatibility with SMPTE 
30 fps timecode.

Important:  Dropframe timecode is not supported when using 59.94 or 60 fps 
progressive scan video.

01:50:20:29

01:50:20:29*

01:50:21:00

01:50:21:00*

01:50:20:28

01:50:20:28*

01:50:20:58

01:50:20:59

01:50:21:00

01:50:21:01

01:50:20:56

01:50:20:57

60 fps60 @ 30 fpsFrames
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Brief Overview of DVCPRO HD Formats

1080i60

1080i60 is a common broadcast format that is frame and field compatible with 
standard definition NTSC video.

Pros
• Individual still frames in this format are very high quality because of the high resolution.
• 29.97 fps frame rate and interlacing are both compatible with standard definition 

NTSC video.

Cons
• Quick action or rapid camera motion may cause interlacing artifacts.

1080i50

1080i50 is frame and field compatible with standard definition PAL video.

Pros
• Individual still frames in this format are very high quality because of the high resolution.
• 25 fps frame rate and interlacing are both compatible with standard definition PAL video.

Cons
• Quick action or rapid camera motion may cause interlacing artifacts.
• Because of the lower frame rate, this format can cause more severe motion 

artifacting than 1080i60.

Note:  This format is not supported in Final Cut Pro HD.

1280 x 720 720 x 4801920 x 1080

1080

60

1280 x 720 720 x 4801920 x 1080

1080

50
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720p60

This format is smaller than 1920 x 1080, but the smaller image dimensions allow the 
frame rate to be doubled. Sports events and other rapid-movement imagery are usually 
broadcast in this format.

Pros
• Yields the highest frame rate possible with the DVCPRO HD format.
• Individual still frames in this format have no motion artifacting (such as flickering 

lines) due to the progressive scanning.
• Captures and displays quick action and fast camera moves smoothly.
• NTSC compatibility because of the 59.94 fps video rate

Cons
• Smaller image size than 1920 x 1080 (though still higher resolution than standard 

definition video)

720p30

720p30 is a particularly flexible format because it is compatible with standard definition 
NTSC video (because it has a matching frame rate of 29.97 fps) as well as streaming and 
downloadable video (because it is progressively scanned). Because of the progressive 
scanning, 720p30 is also useful when you need a video format that can output 
high-quality still frames.

Pros
• Compatible with both standard definition NTSC (29.97 fps) and computer graphics 

(progressive scan)

Cons
• Smaller image size than 1920 x 1080 (though still higher resolution than standard 

definition video)

1280 x 720 720 x 4801920 x 1080

720
60

1280 x 720 720 x 4801920 x 1080

720
30
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720p24

720p24 is sometimes simply referred to as 24p mode, and is considered by some to be 
the most flexible frame rate choice because it is possible to transfer to NTSC and PAL as 
well as to film. Choose this mode if you plan to transfer your finished video to film, or if 
you are trying to emulate a film look on your final video.

Even though the camcorder always records 720p formats at 59.94 fps, most of the 
frames are tagged as duplicates and can be removed during capture. As a result, 
720p24 on your hard disk has a much lower data rate than other DVCPRO HD formats.

Important:  Video transfers using FireWire currently require that 720p24 video actually 
be recorded at the NTSC-compatible speed of 23.8 fps.

Pros
• Perfect for video-to-film transfers because of matching frame rates (23.976 fps)
• 60 percent lower data rate than 720p60 because of the lower frame rate

Cons
• Smaller image size than 1920 x 1080 (though still higher resolution than standard 

definition video)
• Requires an extra telecine pulldown process when transferring to NTSC
• Requires a frame rate increase process when transferring to PAL

Note:  The workflow for capturing, editing, and output of 720p24 is similar to the 
Panasonic DVX100 workflow.

1280 x 720 720 x 4801920 x 1080

720
24
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Recording and Playing Back Variable Frame Rates 
With DVCPRO HD
Some DVCPRO HD devices allow recording and playback of variable frame rates from 
4 to 60 frames per second. Variable frame rate recording and playback are limited to 
the 720p HD format. The camera CCD outputs from 4 to 60 fps (in whole number 
increments), but the built-in VTR records at a constant rate of 60 fps (or 59.94 fps). 
Duplicate frames in the 60 fps video stream are tagged to be removed later by special 
frame rate converter playback units.

For example, if the camera is set to record 15 fps, 3 out of every 4 frames are tagged as 
duplicate and ignored when played back on the frame rate converter. Another useful 
feature of a frame rate converter is that it can output at different frame rates as well, so 
you can record at 60 fps but output your video at 24 fps with a 3:2 pull-down. Some 
frame rate converters can also do upconverting and downconverting, allowing you to 
shoot 720p24f variable frame rate footage and output fast- and slow-motion footage to 
1080i24p or 480i (standard definition) with a letterboxed 3:2 pull-down.
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Used frames Duplicate frames

Recording variable frame rates with DVCPRO HD 720p 

1 2 3 4

After duplicate frame removal 4 fps)

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60

DVCPRO HD tape (60 fps)

1

After duplicate frame removal (30 fps)

302928272625242322212019181716151413121110987654321

DVCPRO HD tape (60 fps)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60

After duplicate frame removal (15 fps)

151413121110987654321

DVCPRO HD tape (60 fps)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60

24 252322212019181716151413121110987654321

After duplicate frame removal (25 fps)

DVCPRO HD tape (60 fps)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60

242322212019181716151413121110987654321

After duplicate frame removal (24 fps)

DVCPRO HD tape (60 fps)

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 60

After duplicate frame removal (60 fps)

DVCPRO HD tape (60 fps)

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 601

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 26 27 28 29 30 31 32 33 3534 3736 38 39 40 41 4342 44 45 4746 48 4925 50 51 5352 54 55 5756 58 59 601
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